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Legal Information

The information provided in this document contains general descriptions, technical
characteristics and/or recommendations related to products/solutions.

This document is not intended as a substitute for a detailed study or operational and
site-specific development or schematic plan. It is not to be used for determining
suitability or reliability of the products/solutions for specific user applications. It is the
duty of any such user to perform or have any professional expert of its choice
(integrator, specifier or the like) perform the appropriate and comprehensive risk
analysis, evaluation and testing of the products/solutions with respect to the relevant
specific application or use thereof.

The Schneider Electric brand and any trademarks of Schneider Electric SE and its
subsidiaries referred to in this document are the property of Schneider Electric SE or
its subsidiaries. All other brands may be trademarks of their respective owner.

This document and its content are protected under applicable copyright laws and
provided for informative use only. No part of this document may be reproduced or
transmitted in any form or by any means (electronic, mechanical, photocopying,
recording, or otherwise), for any purpose, without the prior written permission of
Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the
document or its content, except for a non-exclusive and personal license to consult it
on an "as is" basis.

Schneider Electric reserves the right to make changes or updates with respect to or in
the content of this document or the format thereof, at any time without notice.

To the extent permitted by applicable law, no responsibility or liability is
assumed by Schneider Electric and its subsidiaries for any errors or omissions
in the informational content of this document, as well as any non-intended use
or misuse of the content thereof.



Getting Started

Table of Contents

Safety Information ... 5
About the DOCUMENT ... 6
INtrOAUCHION ... 13
General Introduction to the EcoStruxure Machine Expert Twin ..................... 14
Overview of the EcoStruxure Machine Expert Twin Product
POMfOlIO ...t 14
USEr INtEIfACE ... 15
Overview of the User Interface............ccoooiiiiiiiiiiiiie e 16
Elements of the SCreen ... 16
Information About the Coordinate System.............ccccooviiiiiin e, 17
TOOIDAN ..o e 19
Lo L] o = | PPN 20
MENU BaAr ... .o e 21
FIle MENU. ... e 21
Edit MENU ... 23
VIEW MENU ... 24
Settings MenU ... 26
TOOIS MENU.....oviiii e 28
MOl MENUL........iiee e e 29
FMIMENU. ... e 31
Kinematization Menu.................oooiii 33
Load Handling MenuU ... 50
SMArtVisSuU MENU .......cooouiiiiiiii e 66
Auto-Generation Menu ...............c.oooiiiiii 68
CoNNECLIONS VIEW .....eoiniii e 70
CoNNECLIONS VIBW ...coniiiii e 70
Catalogs VIEW ......oniiiiiiii e 72
Catalogs VIEW ... 72
Control Panel VieW............oooiiii e 73
Control Panel View ..o 73
MOl VIEW... ... 75
MOl VIEBW ... e 75
Managing Tools Within the Model View .............cccccoooiiiiiiiii. 77
Managing Measurements Within the Model View .................ccccooieiieniis 81
SCHIPE VIBW ..o 85
SCrIPt VIBW ..o e 85
LOGS VIBW ..ot 86
LOGS ViBW. .o 86
LOAdS VIEW ..ooeoiiii i 88
LOAAS VIBW.. ... 88
INputs / OULPULS VIEWS ......oiiiiiiiiiii e 89
Inputs / OUtPULS VIEWS........coovvniiiiiii e 89
AlarmS VIEW ... 90
AlArMS VIEW ..ot 90
JOINEEAItOr ... ... 91
JOINt EAItor VIeW ... 91
Logic Configurator ... 95
Logic Configurator View..............c.ciiiiiiiiiii e 95
EI00000005022.05 3



Getting Started

Change History VIEW.............uiiiiiiiii e 96

Change History VIiew ... e 96

Solution EXPIorer VIEW...........oooiiiiiiii e 97

Solution EXplorer VIieW.............c.ooiiiiiiiiiic e 97

Statistics VIEW ......eiiii 100

Statistics VieW.......ooo 100

Properties VIEW........ooouiiiiiie e 101

Properties VIeW ..o 101

Frequently Asked QUESHIONS ..........c.ccooiiiiiiii 104

O P 105
Are Catalogs Saved With the EcoStruxure Machine Expert Twin

PrOJECL? .o 105

How Can | Share a Project with Customized Catalogs?..........c............. 105

How Can | Position an Assembly Up And Down in the Scene? ............. 106

How Can | Link or Snap Conveyors in the Scene? ............ccooeeviiiiis 106

How Can | Create a Random Load in the Scene?...........cc.ooeevviiiiieenn. 106

How Can | Make the Camera View Following a Load? ...........c............. 106

What Can | Use the Script View FOor?..........c.ooooiiiiiiiiiiieee 107

How Can | Streamline the Start-up Process?...........ccoooiiiiiiiiinninnne. 108

GIOSSAIY ... 111

INAEX ... 113

4 EIO0000005022.05



Safety Information

Getting Started

Safety Information

Important Information

Please Note

Read these instructions carefully, and look at the equipment to become familiar
with the device before trying to install, operate, service, or maintain it. The
following special messages may appear throughout this documentation or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an
electrical hazard exists which will result in personal injury if the instructions are not
followed.

hazards. Obey all safety messages that follow this symbol to avoid possible injury or
death.

A DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.

2 This is the safety alert symbol. It is used to alert you to potential personal injury

A WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

A CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction
and operation of electrical equipment and its installation, and has received safety
training to recognize and avoid the hazards involved.

EIO0000005022.05
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About the Document

About the Document

Document Scope

Validity Note

This document describes the graphical user interface of the EcoStruxure Machine

Expert Twin software and the functions it provides. For further information, refer to

the separate documents provided in the EcoStruxure Machine Expert Twin online

help.

This document has been updated for the release of EcoStruxure Machine Expert
Twin V2.3.

Product Related Information

AWARNING

LOSS OF CONTROL

» Perform a Failure Mode and Effects Analysis (FMEA), or equivalent risk
analysis, of your application, and apply preventive and detective controls
before implementation.

* Provide a fallback state for undesired control events or sequences.
» Provide separate or redundant control paths wherever required.
« Supply appropriate parameters, particularly for limits.

* Review the implications of transmission delays and take actions to mitigate
them.

* Review the implications of communication link interruptions and take actions
to mitigate them.

» Provide independent paths for control functions (for example, emergency
stop, over-limit conditions, and error conditions) according to your risk
assessment, and applicable codes and regulations.

* Apply local accident prevention and safety regulations and guidelines.!

» Test each implementation of a system for proper operation before placing it
into service.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

1 For additional information, refer to NEMA ICS 1.1 (latest edition), Safety
Guidelines for the Application, Installation, and Maintenance of Solid State Control
and to NEMA ICS 7.1 (latest edition), Safety Standards for Construction and
Guide for Selection, Installation and Operation of Adjustable-Speed Drive
Systems or their equivalent governing your particular location.

AWARNING

UNINTENDED EQUIPMENT OPERATION

* Only use software approved by Schneider Electric for use with this
equipment.

» Update your application program every time you change the physical
hardware configuration.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

EI00000005022.05
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For reasons of Internet security, for those devices that have a native Ethernet
connection, TCP/IP forwarding is disabled by default. Therefore, you must
manually enable TCP/IP forwarding. However, doing so may expose your network
to possible cyberattacks if you do not take additional measures to protect your
enterprise. In addition, you may be subject to laws and regulations concerning
cybersecurity.

AWARNING

UNAUTHENTICATED ACCESS AND SUBSEQUENT NETWORK INTRUSION

+ Observe and respect any and all pertinent national, regional and local
cybersecurity and/or personal data laws and regulations when enabling
TCP/IP forwarding on an industrial network.

» Isolate your industrial network from other networks inside your company.

+ Protect any network against unintended access by using firewalls, VPN, or
other, proven security measures.

Failure to follow these instructions can result in death, serious injury, or

equipment damage.

Consult the Schneider Electric Cybersecurity Best Practices for additional
information.

EcoStruxure Machine Expert Twin is a simulation and emulation software suite to
create digital models of real machines to start the virtual design, virtual pre-
commissioning, and to support co-development before building the machine —
thus enabling parallel engineering of mechanical, electrical and controls work
assignments.

The simulation, emulation and machine visualization functions of EcoStruxure
Machine Expert Twin are intended to support you in developing your application
and its configuration by simulating the behavior of the various machine or process
components. These functions are not intended to substitute for, but to complement
the processes of risk assessment, risk evaluation, validation, and commissioning
as well as any ancillary processes, tasks, and obligations according to the
applicable regulations and standards such as ISO/EN 13849 and IEC 62061. The
product, though powerful, does not, nor can it, simulate every aspect of the
application and its environment.

AWARNING

INSUFFICIENT TEST COVERAGE

* Do not use EcoStruxure Machine Expert Twin as the sole means for risk
assessment, risk evaluation, validation, and commissioning as well as any
ancillary processes, tasks, and obligations according to the applicable
regulations and standards such as, but not limited to, ISO/EN 13849 and
IEC 62061.

» Verify and validate your results on the intended equipment before placing
your machine or process into service.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

EIO0000005022.05
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Based on the system configuration and operation, a hazard and risk analysis must
be conducted for the system (for example, according to ISO 12100 or ISO 13849-
1) independent of the work with EcoStruxure Machine Expert Twin. The results of
this analysis must be considered when designing the machine, and subsequently
applying safety-related equipment and safety-related functions. The results of
your analysis may deviate from any digital models of physical machines that you
may create. For example, additional safety components may be required. In
principle, the results from the hazard and risk analysis have priority.

AWARNING

NON-CONFORMANCE TO SAFETY FUNCTION REQUIREMENTS

» Specify the requirements and/or measures to be implemented in the risk
analysis you perform.

» Verify that your safety-related application complies to applicable safety
regulations and standards.

» Make certain that appropriate procedures and measures (according to
applicable sector standards) have been established to help avoid hazardous
situations when operating the machine.

» Use appropriate safety interlocks where personnel and/or equipment
hazards exist.

+ Validate the overall safety-related function and thoroughly test the
application.

Failure to follow these instructions can result in death, serious injury, or

equipment damage.

Catalogs contain important data, parameters and operational aspects of the
devices defined within. This information is subject to change over time for a variety
of reasons. Therefore, it is necessary to maintain the relationship between the
models you create and the catalogs you have used to do so. Version mismatches
of catalogs may cause your models to operate in ways that are incongruent with
the equipment they represent and may lead to errors in design and operation.

AWARNING

UNINTENDED EQUIPMENT OPERATION

» Impose a system of file name conventions that readily indicate the version of
the catalogs you use and models you create.

» Create documentation that records catalog and model versions, as well as
firmware versions of the equipment used in your models.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

In addition, changes to your underlying application (logic, data address, functions,
I/O configurations, device types and configuration, etc.) can have serious impact
on the models you have created.

AWARNING

UNINTENDED EQUIPMENT OPERATION

+ Update your models every time you modify your application or change the
physical hardware configuration.

+ Verify that objects you have created in your models are coherent with the
modifications and/or changes you have made to your application and that
they are associated with the correct variables.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

EIO0000005022.05
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It is also important to connect to the correct automation logic/motion controller in a
networked, multi-controller environment.

AWARNING

UNINTENDED EQUIPMENT OPERATION

Verify that you have connected to the intended automation controller.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

It is important to manage the amount of data that is transmitted between your
automation logic/motion controller and EcoStruxure Machine Expert Twin. Large
amounts of data, or data that is not contiguous in the controller memory may
impact performance of EcoStruxure Machine Expert Twin, the controller or both.

General Cybersecurity Information

In recent years, the growing number of networked machines and production plants
has seen a corresponding increase in the potential for cyber threats, such as
unauthorized access, data breaches, and operational disruptions. You must,
therefore, consider all possible cybersecurity measures to help protect assets and
systems against such threats.

To help keep your Schneider Electric products secure and protected, it is in your
best interest to implement the cybersecurity best practices as described in the
Cybersecurity Best Practices document.

Schneider Electric provides additional information and assistance:
» Subscribe to the Schneider Electric security newsletter.
» Visit the Cybersecurity Support Portal web page to:

o Find Security Notifications.

o Report vulnerabilities and incidents.

» Visit the Schneider Electric Cybersecurity and Data Protection Posture web
page to:

o Access the cybersecurity posture.
o Learn more about cybersecurity in the cybersecurity academy.
o Explore the cybersecurity services from Schneider Electric.

Product Related Cybersecurity Information

Refer to the Cybersecurity Guidelines for EcoStruxure Machine Expert, Modicon
and PacDrive Controllers and Associated Equipment User Guide.

NOTE: Schneider Electric adheres to industry best practices in the
development and implementation of control systems. This includes a
"Defense-in-Depth" approach to secure an Industrial Control System. This
approach places the controllers behind one or more firewalls to restrict access
to authorized personnel and protocols only.

EI00000005022.05 9
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AWARNING

UNAUTHENTICATED ACCESS AND SUBSEQUENT UNAUTHORIZED
MACHINE OPERATION

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

Evaluate whether your application environments are connected to your
critical infrastructure and, if so, take appropriate steps in terms of prevention,
based on Defense-in-Depth, before connecting the automation system to
any network.

Limit the number of devices connected to a network to the minimum
necessary.

Isolate your industrial network from other networks inside your company.

Protect any network against unintended access by using firewalls, VPN, or
other, proven security measures such as an Intrusion Prevention System or
Intrusion Detection System.

Monitor activities within your systems.

Prevent subject devices from direct access or direct link by unauthorized
parties or unauthenticated actions.

Install certificates that are issued by publicly known Trusted Certificate
Authorities.

Keep your systems up to date and rely only on legitimate sources.

Prepare a recovery plan including backup of your system and process
information.

For more information on organizational measures and rules covering access to
infrastructures, refer to ISO/IEC 27000 series, Common Criteria for Information
Technology Security Evaluation, ISO/IEC 15408, IEC 62351, ISA/IEC 62443,
NIST Cybersecurity Framework, Information Security Forum - Standard of Good
Practice for Information Security and refer to Cybersecurity Guidelines for
EcoStruxure Machine Expert, Modicon and PacDrive Controllers and Associated
Equipment.

Related Documents

Document title Reference
Cybersecurity Best Practices CS-Best-Practices-2019-340
Cybersecurity Guidelines for EcoStruxure EI00000004242

Machine Expert, Modicon and PacDrive
Controllers and Associated Equipment

EcoStruxure Machine Expert EIO0000004735 (ENG)

DigitalTwinCommunication Library Guide

EcoStruxure Machine Expert Twin How to EIO0000005034 (ENG)

Create Device Catalogs - User Guide

To find documents online, visit the Schneider Electric download center
(www.se.com/ww/en/download/).

Information on Non-Inclusive or Insensitive Terminology

As a responsible, inclusive company, Schneider Electric is constantly updating its
communications and products that contain non-inclusive or insensitive
terminology. However, despite these efforts, our content may still contain terms
that are deemed inappropriate by some customers.

10
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Terminology Derived from Standards

The technical terms, terminology, symbols and the corresponding descriptions in
the information contained herein, or that appear in or on the products themselves,
are generally derived from the terms or definitions of international standards.

In the area of functional safety systems, drives and general automation, this may
include, but is not limited to, terms such as safety, safety function, safe state, fault,
fault reset, malfunction, failure, error, error message, dangerous, etc.

Among others, these standards include:

Standard

Description

IEC 61131-2:2007

Programmable controllers, part 2: Equipment requirements and tests.

1ISO 13849-1:2023

Safety of machinery: Safety related parts of control systems.

General principles for design.

EN 61496-1:2020

Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.

1ISO 12100:2010

Safety of machinery - General principles for design - Risk assessment
and risk reduction

EN 60204-1:2006

Safety of machinery - Electrical equipment of machines - Part 1: General
requirements

I1SO 14119:2013

Safety of machinery - Interlocking devices associated with guards -
Principles for design and selection

I1ISO 13850:2015

Safety of machinery - Emergency stop - Principles for design

IEC 62061:2021

Safety of machinery - Functional safety of safety-related electrical,
electronic, and electronic programmable control systems

IEC 61508-1:2010

Functional safety of electrical/electronic/programmable electronic safety-
related systems: General requirements.

IEC 61508-2:2010

Functional safety of electrical/electronic/programmable electronic safety-
related systems: Requirements for electrical/electronic/programmable
electronic safety-related systems.

IEC 61508-3:2010

Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

IEC 61784-3:2021

Industrial communication networks - Profiles - Part 3: Functional safety
fieldbuses - General rules and profile definitions.

2006/42/EC Machinery Directive
2014/30/EU Electromagnetic Compatibility Directive
2014/35/EU Low Voltage Directive

In addition, terms used in the present document may tangentially be used as they
are derived from other standards such as:

Standard

Description

IEC 60034 series

Rotating electrical machines

IEC 61800 series

Adjustable speed electrical power drive systems

IEC 61158 series

Digital data communications for measurement and control — Fieldbus for
use in industrial control systems

Finally, the term zone of operation may be used in conjunction with the description
of specific hazards, and is defined as it is for a hazard zone or danger zone in the
Machinery Directive (2006/42/EC) and ISO 12100:2010.

NOTE: The aforementioned standards may or may not apply to the specific
products cited in the present documentation. For more information concerning
the individual standards applicable to the products described herein, see the
characteristics tables for those product references.

EIO0000005022.05
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General Introduction to the EcoStruxure Machine
Expert Twin

What’s in This Chapter

Overview of the EcoStruxure Machine Expert Twin Product Portfolio................. 14

Overview of the EcoStruxure Machine Expert Twin
Product Portfolio

Introduction

The EcoStruxure Machine Expert Twin product portfolio consists of the following
segments:

* EcoStruxure Machine Expert Visu

This viewer integrated in EcoStruxure Machine Expert provides a subset of the
functions of EcoStruxure Machine Expert Twin. It allows you to test the
application code and to display a 3-D emulation of the objects, for example,
one multi carrier track or one robot, from within EcoStruxure Machine Expert.
You can reuse the scenes of single machines to virtual commissioning of the
entire machine production line inside EcoStruxure Machine Expert Twin
Builder.

* EcoStruxure Machine Expert Twin

The standalone EcoStruxure Machine Expert Twin application is installed
using the Schneider Electric Software Installer and requires a separate license.
It includes different components:

o EcoStruxure Machine Expert Twin Builder

The Builder License allows the emulation of a machine when the controller
is connected. It includes predefined catalogs that provide objects you can
use as assemblies in your scene.

o EcoStruxure Machine Expert Twin Designer

The EcoStruxure Machine Expert Twin Designer allows the emulation of
machines without a controller being connected (discrete events simulation).

o EcoStruxure Machine Expert Twin Developer

The Developer License allows you to create your own emulation
components and catalogs as well as plugins, tools, interfaces you can
adapt to your workflow, processes and data sources.

14 EI00000005022.05
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Overview of the User Interface

What’s in This Chapter

Elements of the Screen

.................................................................................. 16
Information About the Coordinate System ............ccooiiiiiiiiii e, 17
Default Screen
After initial startup, the default screen is displayed. It consists of the following
elements:
1 | Machine Expert Twin Builder
2 View Settings Tools Model Kinematization Load Handling SmartVisu Auto-Generation
A Y¢ B ® &
Undo Redo Cut  Copy Copy Paste = Select All
(Clipboard)
Clipboard Select
3 T3 Connections T (] Model _E& Script . ) - o Statistics P
4 D Name | Status Protocol _- S _. —~ = % e Total Count  Max.
[11 Catalogs -9 Connections " g
5 —88 Control Panel n % " -~ - - #4 Solution Explorer 1" Statistics
Controls (1) Cfmtrols (2) : = : z §§ propertes P 8
4
. = |search
.................................. | I 00000 000000 1 y
1 3 Logs rox
[ Tail
""""""""""""""""""" [14:17:29.817) Delta Robots (1.2.7.0) catalog loaded -
: 2 [14:17:29.926] Field Equipment (1.2.1.0) catalog loaded = =
4 I » [14:17:29.945] multi carrier (1.2.7.0) catalog loaded v 7
6 L2 Logs ¥ Loads ¥ Inputs [ Outputs ' Alarms Joint Editor “J Change History ~ Logic Config... A 4
1 Toolbar, page 20
2 Menu bar, page 21 with button bar representing the commands corresponding to
the selected menu
3 Model view, page 75, Script view, page 85
4 Connections view, page 70 / Catalogs view, page 72
5 Control Panel view, page 73 providing tabs for different controls
6 Logs view, page 86, Loads view, page 88, Inputs, Outputs views, page 89,
Alarms view, page 90, Joint Editor view, page 91, Logic Configurator view,
page 95, Change History view, page 96
7 Statistics view, page 100 / Solution Explorer view, page 97
8 Properties view, page 101
16
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Information About the Coordinate System

General Definition for 3-D Software Applications

In 3-D software applications, a coordinate system is a mathematical system that is
used to represent the position and orientation of objects in a three-dimensional
space. It consists of three perpendicular axes (X axis, Y axis, and Z axis) that
intersect at a point called the origin.

Color Definition of Coordinates and Denomination of Rotation

The axes of the coordinate system in EcoStruxure Machine Expert Twin are color-
coded as follows:

e X:red
* Y:green
e Z:blue

Denomination of rotational movement around the different axes is as follows:
* Rotation around the X axis: RotX
* Rotation around the Y axis: RotY
* Rotation around the Z axis: RotZ

z

RotZ

RotY

RotX y

Intrinsic Rotations Convention

With reference to the global EcoStruxure Machine Expert Twin coordinate system,
rotations of local assembly coordinate systems of individual body assemblies are
performed according to the intrinsic convention with the default orientation
convention ZYX. In an intrinsic system, each of the elemental rotations is
performed on the coordinate system as rotated by the previous operation(s).

As an example, suppose the three angles specify rotations around the Z, Y, and X
axes are in that order:

¢ The first elemental rotation is around the Z axis.

* For the intrinsic convention the second elemental rotation is performed around
the Y axis in the new position resulting from the first rotation.

» The final rotation around the X axis is performed around the X axis as rotated
by the two previous operations in the intrinsic system.

The relationship between the three axes is fundamental in EcoStruxure Machine
Expert Twin and is used to determine the orientation and position of body
assemblies in a scene.

EI00000005022.05 17
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Order of Rotational Movements

When values for rotational movements of the different types are provided at the
same time, for example, if an object is added by using the orientation values from
the OPC UA structures, rotational movements are executed in the following order:

1. Around the Z axis:

A
v1 y

%

ul

_)

7 X

The vector z is pointing in your direction.

rotZ = (x,uy) = (¥,v1)
The intermediate vectors u7 and v7 are implicit.
2. Around the Y axis:

- -
X ul
_)
w2
- —>
1 Z

The vector v+ is pointing in your direction.

—_—
rotY = (Z,w;) = (uy,x")
The intermediate vectors u1, v1, and w2 are implicit.

3. Around the X axis:

—_ —
z’ w2

‘<“L

—_

X vl

The vector x’is pointing in your direction.
— 7 — 7
rotX = (v7,y) = (W3,2')

The intermediate vectors u1, v1, and w2 are implicit.

18 EI00000005022.05
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Toolbar

Default Elements of the Toolbar

By default, the toolbar provides the following elements:

Element Shortcut Description
New Ctrl + N Create a new project.
Open Ctri+ O Open an existing project.

Your file contains script code created or modified by you or by
someone else. The execution of the script code may
compromise the security of your IT system.

AWARNING

INFORMATION SYSTEM VULNERABILITY

» Ensure the integrity of the script code
contained in the file by ascertaining the
originator and intent of the script before
opening the file.

» Do not open the file if you cannot determine
the originator and intent of the script,
including confirming any modifications that
may have been made.

» Verify and confirm that you want to execute
this code when using the model contained
in the file.

Failure to follow these instructions can
result in death, serious injury, or equipment
damage.

When attempting to open a file with a model containing script
code, you are asked to acknowledge this advisory and accept
responsibility for the execution of the code of the embedded

script.

Save Ctrl + S Save the open project with file extension .Experior.

Lock Ctrl + L Lock the open project: the scene is locked against edits, no
modifications are possible, values are greyed and buttons are
unavailable.

To lock specific elements of a scene, such as an assembly or
a section, refer to the Solution Explorer view, page 97 or the
Properties, page 101 of the specific element.

Play - Play the scene. The Play button enables the physical
simulation.

Show Quick - Click Show Quick Access Toolbar Below the Ribbon to

Access Toolbar shift the toolbar below the menu bar.

Below the Ribbon

/ Show Quick Click Show Quick Access Toolbar Above the Ribbon to

Access Toolbar shift the toolbar above the menu bar.

Above the Ribbon
Right-click this toggle buttons to access the following

commands:
* Minimize the Ribbon:

Run this command from the contextual menu to display or
hide the button bar corresponding to the menu selected in
the menu bar: The buttons are hidden until you run the
Minimize the Ribbon command again or until you select
another menu in the menu bar.

* Customize the Ribbon

Opens the Ribbon customization window and allows
you to customize the buttons and commands displayed in
the menus.
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Menu Bar
What’s in This Chapter
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Kinematization MEeNU ..o e 33
Load Handling MeENU.........coouiiiiiii e e 50
SMANVISU MENU ...t 66
AUto-Generation MENU............cooiuiii e 68
The menu bar is by default extended by a button bar that provides the commands
of each menu in the form of buttons. This chapter describes the default
commands, provided by each menu.

File Menu

Commands of the File Menu

The File menu is grouped in different sections:
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File Section

Command Shortcut Description

New Ctrl + N Creates a new project.

Your file contains script code created or modified by you or by
someone else. The execution of the script code may
compromise the security of your IT system.

AWARNING

INFORMATION SYSTEM VULNERABILITY

» Ensure the integrity of the script code
contained in the file by ascertaining the
originator and intent of the script before
opening the file.

» Do not open the file if you cannot determine
the originator and intent of the script,
including confirming any modifications that
may have been made.

+ Verify and confirm that you want to execute
this code when using the model contained in
the file.

Failure to follow these instructions can
result in death, serious injury, or equipment
damage.

When attempting to open a file with a model containing script
code, you are asked to acknowledge this advisory and accept
responsibility for the execution of the code of the embedded
script.

Open Ctrl+ O Opens an existing project.

As a project file contains executable script code, carefully verify
whether this project file originates from a trusted source
because opening a tampered project file can compromise the
security of your IT system before you click Exit or activate the
check box and click Continue.

Save Ctrl +S Saves the open project with file extension .Experior.
Save As Ctrl + Shift + S | Saves the open project with a file name and in the directory of
your choice.
Import Section
Command Shortcut Description
Merge - Allows you to merge two parts of a machine that have been

designed independently as scenes and saved as EcoStruxure
Machine Expert Twin projects in .Experior file format. For a
step-by-step description, refer to Merging Projects, page 23.

XML - Imports an XML file that has an EcoStruxure Machine Expert
Twin-compatible format. Files of type .Experior or .zip are
supported.

Also refer to Importing a CAD File, page 37 in the Kinematization Menu, page 33.
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Merging Projects

To merge two parts of a machine that have been designed as independent .
Experior projects, proceed as follows:

Step Action

1 Create an EcoStruxure Machine Expert Twin project in .Experior file format for a part of
your machine, for example, a conveyor belt.

2 Save and close this project file.

3 Create a second EcoStruxure Machine Expert Twin project in .Experior file format and
design another part of your machine, for example, a robot.

4 Save the second file and click File > Merge to display a file open dialog box.

5 Browse to the .Experior file you created for the conveyor belt and click Open.

Result: The Merge/Overwrite Objects dialog box opens.

6 Verify the objects that are selected in the dialog box for Insert and Overwrite and adapt
the selections to your needs.

7 Select the option Reuse sections (if they exist in the current model) to add the
assemblies of the conveyor belt project to be merged to an existing section of the open
robot project if the section name is identical and click OK.

Result: In the Solution Explorer view, the conveyor belt is added to the respective
Section node.

&J For a visual illustration of this merging process, refer to the video
sequence in the corresponding online help.

Export Section

Command Shortcut Description

Collada - Exports the assemblies in the scene as a Collada
(COLLAborative Design Activity) file with the file extension .dae
to allow for exchange with other applications.

For importing a Collada file, refer to Importing a CAD File, page 37 in the
Kinematization Menu, page 33.

Help Section

Command Shortcut Description

About - Opens a dialog box providing information about the
components (such as catalogs or plugins) that are loaded.
Furthermore, it provides links to the EcoStruxure Machine
Expert Twin Release Notes and to the Schneider Electric
License Manager allowing you to verify the license status.

Help - Opens the EcoStruxure Machine Expert Twin Online Help.

Edit Menu

Commands of the Edit Menu

The Edit menu is grouped in different sections:
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Clipboard Section

Command Shortcut Description

Undo Ctrl+Z Undoes the action which was most recently executed. Repeated
use undoes the actions back to when the project was opened.

Redo Ctri+Y Restores an action in the open project which has been undone
before.

Cut Ctrl + X Cuts selected parts of the Model view and transfers the selection
to the clipboard.

Copy Ctrl+ C Copies selected parts of the Model view and allows to paste
these parts within the same EcoStruxure Machine Expert Twin
instance.

Copy - Copies the selection to the clipboard and allows for pasting

(Clipboard) between separate EcoStruxure Machine Expert Twin instances.

Paste Ctrl+V Pastes the content from the clipboard at the cursor position.

Select Section
Command Shortcut Description
Select All Ctrl + A Selects all components in the Model view.

View Menu

Commands of the View Menu

The View menu is grouped in different sections:

Windows Section

Command Shortcut Description

Windows - Select the views from the list that should be displayed in the
EcoStruxure Machine Expert Twin screen. The selection is saved
in the general settings. When you open EcoStruxure Machine
Expert Twin next time, the selected views will be displayed.

Reset - Resets the views within the EcoStruxure Machine Expert Twin
screen to the default state in terms of location and state as
indicated in the section Default Screen, page 16.

Colors Section

Command Shortcut Description

Background | - Select the color used for the background in the Model view.

Assembly - Select the color used for the components you have placed in the

Model view. You can select different colors for:
* Assembly: Color of the assemblies.

» Selection: Color of selected components.
* Locked: Color of locked components.

24
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Scene Section

Floor Section

Debug Section

Camera Section

Command Shortcut Description
Rendering - Switch the rendering function On or Off by sliding the control to
the right or to the left.
When rendering is deactivated, no maodifications are displayed in
the scene.
Lock/ - Lock either the entire scene or the selected assemblies to help
Unlock avoid inadvertent actions or unintended modifications.
Sections - Opens a list of sections you created and displays the available
options:
* Show/hide Section
* Lock/unlock Section
+ Enable/disable Section
Command Shortcut Description
AutoCad - Opens a Select AutoCAD Files dialog box that allows you to
import .dwg or .dxf files.
Command Shortcut Description
Level - This command allows you to select the following debug levels:
* None (default)
+ Debug: Additional information is provided in the Logs view.
» Detailed: Graphical indications, applied to the objects in the
scene, that allow you to visualize interactions and forces
applied to those objects, allowing further investigation of the
physics of the simulation.
Command Shortcut Description
Reset F5 Resets the camera to the default mode.
Orthogonal F12 for the Displays the Model view without perspective. This allows you to
Top view visualize the scene from different angles and to align your
components accurately.
The following Orthogonal views are available:
* Top
* Front
+  Left
+ Back
* Right
To return to the default view with perspective, move the camera or
click the View > Reset button.
Fit - Displays all components in the Model view simultaneously.
Camera Ctrl + Shift + | Allows you to save up to 9 different camera positions by pressing
[1...9] [1...9] Ctrl + Shift + a number between 1 and 9.

To go to one of the saved positions, click the Camera button with
the corresponding number or the shortcut Ctrl + the
corresponding number.

EI00000005022.05

25



Getting Started Menu Bar
Command Shortcut Description
Clear - Resets the saved camera positions.
Export - Allows you to export the camera positions to an XML file.
Import - Allows you to import a camera position from an XML file.
Follow Load | - Follows a selected load on the way through the scene.
Shadow Section
Command Shortcut Description
Shadow - Move the slider from Off to Solid to determine how much of a
shadow the production line casts.
Lighting - Select from the list where the light source is placed in the scene.
The following places are available:
« Top
* Front
* Back
e Left
o Perpendicular
> Front
o Back
* Right
o Perpendicular
o Front
o Back
Visibility Section
Command Shortcut Description
Motors Ctrl+ M Click this toggle button to switch the visibility of motors on and
off.
Label Ctrl + E Click this toggle button to switch the visibility of labels on and
off. Labels are displayed as tooltips when hovering over an
assembly in the Model view.

Settings Menu

Commands of the Settings Menu

Click the Settings button to open the view for configuring the settings for the
different functions and features. It is grouped in different sections:

26
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Camera Section

The Camera area allows you to configure shortcut keyboard keys for moving the

cameras.

By default, the Use Standard Configuration check box is not selected. To define
your own shortcuts, enter the key you want to use per camera movement in the

different lines.

To use the following default keys, select the Use Standard Configuration check

box:
Camera movement Default keyboard key
Forward w
Backward S
Pan Left A
Pan Right D
Rotate Left Left Arrow
Rotate Right Right Arrow
Zoom In Up Arrow
Zoom Out Down Arrow

Snapping Section

The Snapping area allows you to enter the radius (in meters) in which the
assembly snaps to the nearest assembly automatically while double-clicking the
assembly and holding down the Ctrl key.

Globalization Section

The Globalization area allows you to select the Measurement System: Metric or

Imperial.

Pointer Section

Check box

Setting

Keep the selection when placing
a new assembly

If the check box is not selected, the new assembly continues
to follow the arrow pointer when you move it around the
scene.

If the check box is selected, the new assembly is placed at
the position that you click first.

To be able to move and rotate
you have to hold down the left
mouse button when this feature
is enabled.

Select this check box to help avoid moving the assembly
unless you hold down the left mouse button while turning it.

Invert rotation

Change the way you move across the screen with the
mouse.

EI00000005022.05
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Copy/Paste Section

Function / Feature

Setting

Mode

Select where to insert an assembly you copied:

* Mouse: The copied assembly is inserted at the position of
the mouse.

« Offset: The copied assembly is inserted next to the
source object.

Snap

Select this check box to snap a copied assembly to the
nearest assembly. As a prerequisite, the assembly must be
equipped with snapping points.

Continuously Copying

Select this check box to place assemblies continuously with
an offset related to the last assembly you pasted.

Statistics Section

Function / Feature

Setting

Random Seed

Click the up or down buttons to set the number you wish to
use to initialize a pseudo-random sequence.

Warn on determinism lost

Select this check box to display advisory messages when the
random sequence differs from the previous random
sequence.

Visibility Section

Check box

Setting

See assemblies being
constructed

Select this check box to see how the scene builds up when
you load it instead of displaying all components at once.

Display warning signs in locked
mode

Select this check box to display advisory messages when the
scene is locked.

Tools Menu

Commands of the Tools Menu

The Tools Menu is grouped in different sections:

Capture Section

Command Description

Screen Shot Takes a screen capture of the Model view that you can save to a folder of your
choice in .png or .jpg format.

Assembly Shot | Takes a screen capture of the assemblies you selected in the Model view. You
can save it to a folder of your choice in .png or .jpg format.

28
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Measure Section

Click the Measure button and then click within the Model view to display a
measuring tape. It is a good practice to switch to top view for displaying the
measuring tape.

To measure the distance between different components, hold down the Ctrl key to
snap the tape to snap points. An alternative method, which is not as accurate, is to

drag the arrows of the tape.

Model Menu

Commands of the Model Menu

The Model menu is grouped in different sections:

Time Section

Command Shortcut Description

Play - Starts the physical simulation.

Scale - Click to open the list of available execution speeds for the scene

and select a speed rate.
NOTE: Selecting an execution speed higher than 1 can lead
to inaccuracies.
The option 1x sets the execution speed to real time which is
indicated by 1 displayed in the status bar below the Model view.
Alternatively, click the button 1:1 for real time setting.

Increase - Click to increase the execution speed by 0.1.

Decrease - Click to decrease the execution speed by 0.1.

Infinity - Click to set the execution speed to 10.

NOTE: Selecting an execution speed higher than 1 can lead
to inaccuracies.

1:1 - Click to set the execution speed to real time.

Reset Ctrl +R Click to reset time and machines to 0 and to delete the loads.
NOTE: To reset the recording of events, click the Reset
button.

Single Step - Switch the Single Step function On by sliding the control to the

right to pause after every time step.

Event Recorder Section

The commands provided in this area allow you to record events that occur during
connection to a controller and save this recording to a separate *.events file. This
file can be replayed to allow for reviewing the behavior of the scene or to perform
repetitive tests with a fixed timing without a controller being connected.
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Command Shortcut Description
Record / - Connect to a controller and click to start / stop the recording of
Stop events being displayed in the Model view. Events include, for
example, incoming TCP/IP messages, signals from a controller
Replay (controller outputs), manual feeding of loads.
After you have loaded a *.events file, click the Replay button to
start replaying the recording.
While replaying an events file, further information on the events is
provided in the status bar at the bottom of the Model view.
Load - Click to load event recordings.
As a prerequisite for replaying a recording, do the following:
» Disconnect from the controller from which you recorded the
events.
» Click the Reset button from the Time area to reset the scene.
Save - Click to save event recordings in *.events format.
Options - Click to open the options for event recordings:
* Pause when buffer is empty
» Display the time for next recorded event
Statistics Section
Command Shortcut Description
Snapshot - Click to open a Save As dialog box allowing you to export the
information about the scene and to save them as .csv file.
Info - Opens a Model Information window that provides information
about the number of Assemblies, Motors, Parts, Connections,
Outputs, Inputs, PhysX available in the scene you are playing.
Selectables Section
Command Shortcut Description
Filter - Click to open the list of components of the scene that can be
selected: Loads, Assemblies, Motors, Nodes.
Loads Section
Command Shortcut Description
Move - Click to prevent loads from being moved.
Eat - Click to automatically delete loads that have fallen to the floor.
Routes Section
Command Shortcut Description
Auto / Man - Click to select whether you want EcoStruxure Machine Expert

Twin to calculate routes on the assembly line if more than one
option is available, or if you want to do it manually.

30
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FMI Menu

General Information

The FMI menu allows you to import simulation models available as Functional
Mock-up Unit (*.fmu) files that comply with the Functional Mock-up Interface (FMI)
standard.

FMl is a platform-independent standard for exchanging dynamic simulation
models. The relevant XML files, binaries and C code that define the dynamic
simulation models are distributed as a compressed file with the file extension *,
fmu. To create dynamic simulation models, use a supported simulation software
and ensure that your export meets the requirements outlined in Requirements for
the *.fmu File, page 31 to help ensure that the *.fmu file is compatible with
EcoStruxure Machine Expert Twin during import.

Requirements for the *.fmu File

To create the dynamic simulation model, use a simulation software that is
supported by the FMI standard. Refer to the list provided on https://fmi-standard.
org/tools/.

When you export the dynamic simulation model from your simulation software,
ensure the following requirements are met:

» Export the Functional Mock-up Unit (*.fmu) file that complies with the FMI
(Functional Mock-up Interface) standard version V2...

» Export to Co-Simulation Standalone Functional Mock-up Unit to include
the local solver.

NOTE: A Model Exchange export does not include the local solver and is
not compatible with EcoStruxure Machine Expert Twin.

Importing an *.fmu File into EcoStruxure Machine Expert Twin

To import an *.fmu file into EcoStruxure Machine Expert Twin, proceed as follows:

Step Action

1 Select an assembly in the Model view, page 75.

2 From the FMI menu, click the fmu Functional Mock-up Unit Import button.

Result: The Import FMU dialog box is displayed.

3 Browse to the *.fmu file and click Open.

Results:

» The imported Functional Mock-up Unit is displayed as a new subnode of the selected
assembly in the Assembilies tree of the Solution Explorer view, page 97.

* A new block representing the imported Functional Mock-up Unit is displayed in the
Logic Configurator view, page 95.
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Configuring Logical Relations

To configure logical relations for the FMU, proceed as follows:

Step Action

1 Select the FMU node in the Assemblies tree.

2 Right-click anywhere in the Logic Configurator view, and click Create Node(s) >
Create Register Node(s) from the contextual menu.

Result: A block for the FMU is created in the Logic Configurator view providing the
relevant inputs and outputs for establishing relations to other blocks. For further
information, refer to the EcoStruxure Machine Expert Twin Logic Configurator User
Guide.

Managing Scalar Measurements

To view detailed information about the scalar variables of the FMU, use the
Measurements Handler that is available from the contextual menu of the FMU
block in the Logic Configurator.

Commands of the Measurements Handler

Right-click the FMU block in the Logic Configurator view to open the
Measurements Handler contextual menu with the following commands:

Command Description

Enable / Disable Measurements Run this command to enable or disable the measuring
function for the selected body assembly.

By default, the function is disabled.

Export Multiple Measurements The Export Multiple Measurements command allows you
to export the values of measurands to a .csv file.

Run the command to open the Multi Measurand Exporter
dialog box, page 84.

Add Measurements The command is available after the function is enabled with
the Enable Measurements command. It allows you to add
the scalar values that are provided by the FMU block
individually, or with the command Add All.

Plot The plotting capability allows you to trace the values of scalar
variables over time.

Select an individual scalar variable or the command Plot All
to display them in a Measurand Plotter view, page 83.
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Kinematization Menu

Commands of the Kinematization Menu

Create Section

The Kinematization menu is grouped in different sections:
+ Create Section, page 33

» Assembly Section, page 42

* URDF Section, page 43

* Smart Cams Section, page 43

It allows you to create body assemblies and kinematic axes, as well as import
CAD files and create customized kinematics with these elements, grouping them
into container assemblies. By default, they are inserted at the center of the Model
view, represented by the origin of the global coordinate system. If the value of the
Z coordinate of the global coordinate system is 0, an offset of 500 mm is added for
the new objects in the Z direction to help ensure that new objects are visible and
not hidden or obscured by the workspace floor.

The Create section allows you to create body assemblies of the selected type
within the scene at the center of the Model view represented by the origin of the
global coordinate system. When a body assembly is selected, its local coordinate
system is displayed in the scene and its properties are displayed in the Properties
view, page 34.

Command Description

Box Click to add a box to the scene at the center of the Model view represented by
the origin of the global coordinate system.

Cylinder Click to add a cylinder to the scene at the center of the Model view represented
by the origin of the global coordinate system.

Sphere Click to add a sphere to the scene at the center of the Model view represented
by the origin of the global coordinate system.

CAD/Convex The CAD/Convex command provides the subcommands Import and Update.

Select the Import command to import a *.dae, *.stl, *.stp, *.step, *.sldprt or *,
CATPart file and to add the CAD drawing together with the convex mesh at the
center of the Model view represented by the origin of the global coordinate
system.

NOTE: In case your CAD file does not contain information on units (such
as millimeter or inch), EcoStruxure Machine Expert Twin by default
interprets the dimensions of objects as meter. To achieve a correct
interpretation of dimensions, rescaling in your CAD tool may be required
before importing the file into EcoStruxure Machine Expert Twin.

For further information, refer to Importing a CAD File, page 37.

Select the Update command to update CAD files you had split on import into
sub elements that are represented as individual assemblies.

For further information, refer to Updating a CAD File, page 39.

Kinematic Axis | Click to add a kinematic axis at the center of the Model view represented by the
origin of the global coordinate system.

Alternatively, select one or multiple body assemblies before clicking the
Kinematic Axis button. One kinematic axis is then created as parent node per
selected body assembly.

A kinematic axis allows you to move the associated body assembly or imported
CAD object within the scene. The motion can be controlled by controller signals
or a motor can be added as sub device to the kinematic axis to generate
motion.

For further information, refer to Properties of a Kinematic Axis, page 39.
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Properties of Body Assemblies

To customize a body assembly you have added to your scene using the
Kinematization menu, select it in the Model view and configure your settings in
the Properties view.

With the Dynamics > Parameters, configure the following:

Parameter

Description

Type

Select from the list:

+ Bodiless: The body assembly is displayed only for visualization
purposes. No interaction with other objects in the scene or with the
physics is performed.

* Rigid: The body assembly interacts with other objects in the scene but is
not subjected to gravitational forces.

« Physics: The body assembly interacts with other objects in the scene
and is subjected to gravitational forces.

Min Position

Enter the minimum number of iterations executed by the physical simulation

Iterations to calculate the position of the body assembly based on the forces acting on
it.
Default value: 4
Min Velocity Enter the minimum number of iterations executed by the physical simulation
Iterations to calculate the velocity of the body assembly based on the forces acting on
it.
Default value: 1
Friction Click the Friction arrow to open the following list of parameters that define
the friction properties for the body assembly.
» Dynamic: Dynamic friction is the frictional force encountered when two
objects are in motion relative to each other.
« Static: Static friction is the frictional force that needs to be overcome
when an object starts moving, for example, after a reset.
« Coefficient: This is a selection for the type of friction you want to apply.
Select a value from the list:
> None: No friction
o Slippy: Low friction
> Smooth: Medium friction
o Sticky: High friction
o Custom: Allows you to define customized friction parameters.
NOTE: If Custom is selected, enter a value of your choice. For the
predefined friction types, the value is not editable.
Center Of Mass The center of mass is a specific point at which the mass of the body can be

considered to be concentrated. By default, the center of mass is set at 0:0:0
mm.

The center of mass position is relative to the origin of the geometry of the
body assembly. For primitive geometries, such as box, cylinder, and sphere
the origin is located at the center of the volume. In case of convex
geometries (3-D CAD models), the origin is specified in the file.

To shift the center of mass, edit the X, Y, and Z coordinate of the local
coordinate system.
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Parameter

Description

Center Of Mass
Visualization

Select this option to display the center of mass of the selected body
assembly in the scene when the default view is selected. It is represented by
a sphere containing the center of mass symbol that is displayed relative to
the origin of the body assembly.

Weight

Enter the weight of your body assembly (in kg).

Default value: 1 kg

Collision

The property is available if the parameter Type is set to Rigid or Physics.

It allows you to enable or disable collision detection with body assemblies in
the scene without impact on the collider. It is mainly used for Physics
Joints.

Gravity

The property is available if the parameter Type is set to Physics.

It allows you to enable or disable the effect of gravity on the selected body
assembly. It is mainly used for Physics Joints.

With the Geometry > Parameters, configure the following:

Parameter

Description

Type

Select the type of your body assembly and configure the corresponding sub
parameters. You can change the type whenever required.

+ Box
o Length
o Height
o Width

+ Cylinder
> Length
o Radius

+ Sphere
° Radius

+ CAD/Convex

o Scale: Enter the scale factor to resize a CAD drawing with respect to
the original size. The default value is 1 (no scaling).

Local Position

Edit the X, Y, and / or Z coordinate to modify the position of the body
assembly with reference to the origin of its own assembly coordinate
system.

Default value: 0:0:0 mm
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Parameter

Description

Local RotX

Enter a rotation angle in ° to rotate the body assembly around the X axis of
its assembly coordinate system.

Default value: 0°

Local RotY

Enter a rotation angle in ° to rotate the body assembly around the Y axis of
its assembly coordinate system.

Default value: 0°

Local RotZ

Enter a rotation angle in ° to rotate the body assembly around the Z axis of
its assembly coordinate system.

Default value: 0°

Visible

Clear the check box to hide the body assembly from the scene. With the
check box cleared, the body assembly is not displayed. When it is selected
(for example, in the Properties view) its assembly coordinate system is
displayed along with the body assembly.

With the Global Pose parameters, configure the following:

Parameter

Description

Position

Edit the X, Y, and / or Z coordinate to modify the position of the body
assembly within the scene.

Default value: 0:0:0 mm

RotX

Enter a rotation angle in ° to rotate the assembly and its local assembly
coordinate system around the X axis.

Default value: 0°

RotY

Enter a rotation angle in ° to rotate the assembly and its local assembly
coordinate system around the Y axis.

Default value: 0°

RotZ

Enter a rotation angle in ° to rotate the assembly and its local assembly
coordinate system around the Z axis.

Default value: 0°

Select the Position > Locked check box to lock the position of the body assembly
to help prevent it from being moved within the scene.

The Scripts > Event parameters allow you to configure programming code that is
executed when a selectable event is detected on the body assembly:

Parameter

Description

Events

Select one of the following Events:
* Deselect

* DoubleClick

* Reset

+ Select

Click the Source > ... button of the event to open the Script
view, page 85.

The Visualization parameters allow you to configure programming code that is
executed when a selectable event is detected on the body assembly:

Parameter

Description

Visible

Clear this check box to hide the body assembly in the scene.

Color

If the Visible check box is selected, select a color for the
body assembly.
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Importing a CAD File

EcoStruxure Machine Expert Twin supports the import of files with the file
extensions *.dae (Collada file), *.stl, *.stp, *.step, *.sldprt (SolidWorks) or *.
CATPart (Catia).

NOTE: In case your CAD file does not contain information on units (such as
millimeter or inch), EcoStruxure Machine Expert Twin by default interprets the
dimensions of objects as meter. To achieve a correct interpretation of
dimensions, rescaling in your CAD tool may be required before importing the
file into EcoStruxure Machine Expert Twin.

To add a CAD drawing together with the convex mesh at the center of the Model
view represented by the origin of the global coordinate system, proceed as

follows:

Step

Action

1

Click the CAD/Convex > Import button from the Kinematization menu.

Result: The Import CAD dialog box is displayed.

Browse to the CAD file and click Open.

Results: The Selective Import dialog box is displayed.

Use the parameters of the Selective Import and PartSelection dialog boxes to adjust
the level of detail of the CAD file to be imported. This reduces the computational
resources required to depict the scene using a model with reduced complexity. For
details on the parameters, refer to Selective Import Dialog Box and PartSelection
Dialog Box.

Click OK to proceed.

Results:

» If you selected an * st/ file for import, the content of the file is displayed as a new
assembly in the scene and one new node is added to the Assembilies tree of the
Solution Explorer.

+ Ifyou selected a *.dae, *.stp, *.step, *.sldprt, or *. CATPart file for import, a message
is displayed asking whether you want to import this file as one assembly to the scene
(proceed with step 4a) or to split it into its sub-assemblies (proceed with step 4b).

4a

To import the CAD file as one assembly to the scene, click No.

Result: The content of the file is displayed as new assembly in the scene and one new
node is added to the Assembilies tree of the Solution Explorer.

4b

To split the CAD file into its sub elements and to import them as individual assemblies,
click Yes.

Result: The content of the file is displayed as new assembly in the scene and several
new nodes are added to the Assemblies tree of the Solution Explorer representing the
sub elements that exist in the CAD file.

Selective Import Dialog Box

The parameters of the of the Selective Import dialog box allow you to define the
granularity of the CAD file to be imported:
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Element

Description

Level of Detail list

Allows you to reduce the complexity of the CAD file by applying the Custom
Tesselation parameters to indicate the differences between the levels:

« Extra Low
* Low
* Medium (default setting)

* High
« Extra High
* Custom:

NOTE: With the Custom option selected, the PartSelection dialog
box allows you to select specific parts for excluding them from the
import.

Custom
Tesselation section

The values and sliders provided for Chord Limit and Angle Tolerance are
determined by the selected Level of Detail.

To set the parameters manually, select the option Custom from the Level of
Detail list.

Selective Import

option

Select the option and click OK to open the PartSelection dialog box.

PartSelection Dialog Box

The PartSelection dialog box allows you to adjust the required level of detail for
the CAD file to be imported. It lists all parts of the CAD file on the left-hand side
and provides a column on the right-hand side to display the part or parts you
excluded from the import.

List providing the parts of the CAD file on the left-hand side:

Element

Description

Select Parts With
Same Name check
box

Select this check box to choose a part from the list on the left-hand side of
the PartSelection window. The parts with the same name are automatically
selected and displayed in a list on the right-hand side.

Select Instanced
Parts check box

Select this check box to choose a part from the list on the left-hand side of
the PartSelection window. The parts originating from the same instance are
automatically selected and displayed in a list on the right-hand side.

Select Parts With A
Volume Less Than:
<x> cm3 text entry
box

Enter a volume value in the ecm3 text entry box to display only parts with a
value smaller than the entered value. The parts that meet this criterion are
automatically selected and displayed in the list on the right-hand side.

List providing the selected parts on the right-hand side:

Element

Description

X button

Each selected part entry has an X button. Click this button to remove an
individual part from the list on the right-hand side of the PartSelection
window and return it to the list on the left-hand side.

Alternatively, you can double-click a part in the right-hand list to remove it
from the list.

Deselect all parts:
Deselect button

Click the Deselect button to remove the selected parts from the right-hand
listin the PartSelection window. The parts are moved back to the list on the
left-hand side.

Omit selected
parts from import:
OK / Cancel button

To proceed with steps 4a/4b of the import procedure, page 37 of the CAD
file and exclude the parts listed on the right-hand side of the PartSelection
window, click the OK button.

To cancel selecting parts, click the Cancel button.
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Updating a CAD File

EcoStruxure Machine Expert Twin allows you to update CAD files you had split on
import into sub elements that are represented as individual assemblies.

To update a CAD file, proceed as follows:

Step Action

1 Save the EcoStruxure Machine Expert Twin before starting the update process. If you
have not saved your project, you will be prompted to save before the import is started.

2 Select the previously imported CAD file in the Solution Explorer.

3 Click the CAD/Convex > Update button from the Kinematization menu.

Result: The Update CAD dialog box is displayed.

4 Browse to the updated CAD file, select it and click Open.

Result: The Update CAD dialog box is displayed and lists the differences between the
two file versions. On the left-hand side, it lists the sub elements as they are available in
EcoStruxure Machine Expert Twin and displayed in the Solution Explorer view. On the
right-hand side, the sub elements are listed that are available in the CAD file on the file
system.

5 Compare the differences and decide which modifications you want to accept or ignore.

To ignore a modification of an element, click the minus button at the right end of the
respective line and select the Ignore command.

Result: The selected line or group of elements is displayed greyed and will not be
updated.

6 Click the Update button to start updating the CAD file.

CAD file comparison is performed locally using information stored within the
model without relying on external hosting services. As a result, updating a CAD
file overwrites the present model information. The CAD update functionality is not
available for files with subnodes that share the same name under a common
parent node. In this case it is not possible to distinguish and compare versions.

Properties of a Kinematic Axis

To customize a kinematic axis you have added to your scene using the
Kinematization menu, select it in the Model view and configure your individual
settings in the Properties view.

The Coordinate Axes > Properties parameters allow you to configure the local
coordinate system of the kinematic axis:

Parameter Description

Scale Allows you to scale the axes of the assembly coordinate system of the
kinematic axis that is selected.

Default value: 1.5

Visible Clear this check box to hide the local coordinate system of the selected
kinematic axis in the scene.

EI00000005022.05 39



Getting Started Menu Bar

The Global Pose parameters allow you to configure the kinematic axis with
reference to the global coordinate system of the scene:

Parameter Description
Position Edit the X, Y, and / or Z coordinate to modify the position of the kinematic
axis.

Default value: 0:0:0 mm

RotX Enter a rotation angle in ° to rotate the kinematic axis around the X axis of
the global coordinate system.

Default value: 0°

RotY Enter a rotation angle in ° to rotate the kinematic axis around the Y axis of
the global coordinate system.

Default value: 0°

RotZ Enter a rotation angle in ° to rotate the kinematic axis around the Z axis of
the global coordinate system.

Default value: 0°

From the Motion > Type list, select the following options:

Parameter Description
Fixed The kinematic axis is fixed and the associated body assemblies are not
moved.

This is the default setting.

Translation The kinematic axis exerts a translational movement on the associated body
assembly.

Rotation The kinematic axis exerts a rotational movement on the associated body
assembly.
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With Motion > Type selected, the following parameters are available:

Parameter

Description

Axis

Select the direction of movement based on the assembly coordinate system:
+ X
- Y
- Z

NOTE: The assembly coordinate system can be rotated which can
have the effect that the directions differ from the global coordinate
system.

Invert Direction

Select the Invert Direction check box to move the kinematic axis by default
in the negative direction.

Drive Type

The options add a Motor as sub node to the Kinematic Axis node.

Select an option from the list to define the controller input that is valid for the
motor:

» Position: A position value for the motor (in Units) is provided by a
variable from the controller.

* Velocity: A velocity value for the motor (in Units) is provided by a
variable from the controller.

* Forward/Backward: Boolean forward/backward signals are provided by
a variable from the controller.

+ Custom: Select this option to use customized motors or positioners. If
they meet the requirements defined in Customized Motors or
Positioners, page 42, they are available for selection in the Custom
Drive list and can be added to the selected kinematic axis.

The motor is configured with the parameter Drive in this list of Motion
parameters.

Custom Drive

Click the arrow to open a list of customized motors or positioners that meet
the requirements defined in Customized Motors or Positioners, page 42.
Select an entry to add it to the selected kinematic axis.

Units

Select the units of movement:
* For translational movement:
o Millimeters
o Meters
» For rotational movement:
o Degrees
o Radians

Limits

To limit the movement, activate the option Use Limits and configure the
parameters (the units configured with the Units parameter are used):

* Min. Limit
» Max. Limit
* PLC Input - Min. Limit
* PLC Input - Max. Limit

Drive

Configure the motor according to the selection for the parameter Drive
Type.

The motor parameters are configured as described in the How to Use
Device Catalogs User Guide. Alternatively, you can right-click the motor
node in the Solution Explorer and control the motor manually with the
Stop, Start, Forward, Backward commands

Select the Position > Locked check box to lock the position of the kinematic axis
to help prevent it from being moved within the scene.

The Scripts > Event parameters allow you to configure programming code that is
executed when a selectable event is detected on the kinematic axis:
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Parameter

Description

Events

Select one of the following Events:
+ Deselect

* DoubleClick

* Reset

+ Select

Click the Source > ... button of the event to open the Script
view, page 85.

The Visualization parameters allow you to configure programming code that is
executed when a selectable event is detected on the kinematic axis:

Parameter Description
Visible Clear the check box to hide the kinematic axis in the scene.
Color If the Visible check box is selected, select a color for the

kinematic axis.

Customized Motors or Positioners

You can configure customized motors (to move the kinematic axis by speed) or
positioners (to move the kinematic axis by controller inputs). To make them
available in EcoStruxure Machine Expert Twin, select the Drive Type > Custom
option. Your motors and positioners catalogs or plugins will be displayed for
selection in the Custom Drive Type list if they fulfill the following prerequisites:

* Motors use inheritance from Experior.Core.Motors.Electric.

» Positioners use inheritance from Experior.Plugin.Kinematization.Actuators.
Positioner.Positioner.

+ The catalog or plugin files are stored in the EcoStruxure Machine Expert Twin
installation folder.

Assembly Section

Command Description
Assembly Click the Assembly Container button to create an empty assembly container.
Container It allows you to group body assemblies and to create parent-child relationships.

A new node Container is added to the Solution Explorer view. When this
node is selected, the empty assembly is represented by a local coordinate
system in the scene.

Tool Container

Click the Tool Container button to create an empty tool container. It allows you
to group body assemblies and to create parent-child relationships. Note that
this container type is exclusively to be attached to robotic assemblies using the
Tool Manager > Attach New Tool > Custom Tool command.

A new node Custom Tool is added to the Solution Explorer view. When this
node is selected, the empty assembly is represented by a local coordinate
system in the scene.
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URDF Section

Command

Description

Attach

Creates parent-child relationships between assemblies or kinematic axes.

To achieve this, select a container or a body assembly or a kinematic axis in the
scene or in the Solution Explorer, hold down the Ctrl key and select another
body assembly or a kinematic axis. Click the Attach button.

As a result, the second assembily is displayed as a sub node of the first
assembly in the Solution Explorer view. In the scene, the two assemblies act
as one assembly. The relative relationship is fixed and is maintained while
moving them within the scene.

You can attach more body assemblies to the same parent assembly or you can
create another hierarchy level by selecting the child assembly in the scene orin
the Solution Explorer, holding down the Ctrl key and selecting another body
assembly.

Unattach

Removes a parent-child relationship between assemblies and kinematic axes.

To achieve this, select an assembly in the scene or in the Solution Explorer
that is a child of another assembly. Click the Unattach button to untie this
relationship.

As a result, the former child assembly is now displayed as a node in the root
level of the Solution Explorer view. In the scene, there is no longer a fixed
relative relationship between the two assemblies.

Command

Description

Import

Click to import a URDF (Unified Robotics Description Format) file or
alternatively an XML (eXtensible Markup Language) file that contains the
adequate information. Browse to the file in the Importing URDF File dialog box
and click Open.

Result: The imported robot is displayed in the scene and a new node is created
in the Solution Explorer view with sub nodes representing the body
assemblies and kinematic axes the robot consists of.

Smart Cams Section

The smart cams function allows you to import .asc files created with the Motion
Sizer that describe cubic spline interpolated profiles. For a detailed description of
this file type, refer to the Interpolated Profile File Format (.asc) chapter of the
Motion Sizer Online Help. A position profile is imported as a subnode of a selected
assembly and modifies the pose (the position and orientation) of the assembly
according to a master axis that is linked to this cam. One or more master axes can
be configured in a project and are displayed as assembly nodes in the Solution
Explorer view. Each cam must be linked to one master axis. The master axis acts
as a virtual shaft and defines the reference position for the subordinate cams.
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Command

Description

Master Axis

Click to create a Master Axis in the Model view at cursor position. The master
axis acts as a virtual shaft that defines the reference position for subordinate
cam axes.

The master axis is represented in the Model view by a local coordinate system
that is by default displayed in green (also refer to the global EcoStruxure
Machine Expert Twin coordinate system and the local assembly coordinate
systems described in chapter Information About the Coordinate System, page
17).

In the Solution Explorer view, a Master Axis node is created.

For configuring a master axis, refer to Properties of a Master Axis, page 45

Create Cam

Click to create a cam. As a prerequisite for creating a cam, select an assembly
of the following type:

» Cobot (6 cams allowed)

* Delta Robots (3 or 4 cams allowed)

» Kinematic Axis (1 cam allowed)

» Scara (4 cams allowed)

« Servo Belt (1 cam allowed)

For configuring a cam, refer to Properties of a Cam Diagram, page 48.

Remove Cam

Click to remove a cam selected in the Model view or in the Solution Explorer
view.
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Properties of a Master Axis

To customize a master axis you have added to your scene using the
Kinematization menu, select it in the Model view or in the Solution Explorer
view and configure your individual settings in the Properties view.

The Cams > Items parameters list the cam diagrams that are linked to the master
axis. On the left-hand side of the list, the consecutive number of the cam diagram
is displayed, starting with [0]. On the right-hand side, the name of the cam
diagram is displayed as defined in the Properties of a Cam Diagram, page 48 plus
the assembily it is assigned to (Cobot, Delta Robot, Kinematic Axis, Scara or

Servo Belt).

Example:

[0]Caml in Kinematic Axisl
[1]Cam2 in Cobot
[2]Cam3 in Scara
[3]Cam4 in Scara

NOTE: Assign meaningful names to the cam diagrams to ease this linking
process between master axes and cam diagrams.

The Coordinate Axes > Properties parameters allow you to configure the local
coordinate system of the master axis:

Parameter Description

Scale Allows you to scale the axes of the assembly coordinate system of the
master axis that is selected.
Default value: 1.5

Visible Clear this check box to hide the local coordinate system of the selected
master axis in the scene.

The Global Pose parameters allow you to configure the master axis with
reference to the global coordinate system of the scene:

Parameter Description

Position Edit the X, Y, and / or Z coordinate to modify the position of the master axis.
Default value: 0:0:0 mm

RotX Enter a rotation angle in ° to rotate the master axis around the X axis of the
global coordinate system.
Default value: 0°

RotY Enter a rotation angle in ° to rotate the master axis around the Y axis of the
global coordinate system.
Default value: 0°

RotZ Enter a rotation angle in ° to rotate the master axis around the Z axis of the

global coordinate system.

Default value: 0°

The Motion > Control Mode list allows you to select a control mode to modify the

position over time.

Parameter Description

Start/Stop The master axis is operated in Start/Stop mode.
Jog The master axis is operated in Jog mode.
Velocity The master axis is operated in Velocity mode.
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With Motion > Control Mode > Start/Stop selected, you can right-click the
master axis in the Model view and run the commands Forward and Backward
from the contextual menu. The following Controller parameters are available:

Acceleration

Parameter Description
Speed Enter a velocity for the movement of the master axis in deg/s.
Enable Select the option to enable acceleration control and configure the following

parameters:

* Ramp Up: Enter the maximum time (in ms) to elapse until the master
axis has reached the configured Speed after the Start command.

* Ramp Down: Enter the maximum time (in ms) to elapse until the master
axis has reached standstill after the Stop command.

PLC Output - Invert
Direction

Configure an output variable from the controller to invert the motion direction
of the master axis.

When TRUE, the default motion direction is inverted and motion is executed
in the negative direction.

« Size: Indicates the data type of the variable (BOOL).

« Description: Enter a describing text.

» Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.

PLC Output - Start/
Stop

Configure an output variable from the controller for starting and stopping the
master axis.

When TRUE, the master axis is started.

« Size: Indicates the data type of the variable (BOOL).

» Description: Enter a describing text.

« Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.

With Motion > Control Mode > Jog selected, you can right-click the master axis
in the Model view and run the commands Jog Forward and Jog Backward from
the contextual menu. The following Controller parameters are available:

Parameter

Description

Step

Enter a step width for the movement of the master axis in degrees.

PLC Output - Invert
Direction

Configure an output variable from the controller to invert the motion direction
of the master axis.

When TRUE, the default motion direction is inverted and motion is executed
in the negative direction.

« Size: Indicates the data type of the variable (BOOL).

« Description: Enter a describing text.

« Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.

PLC Output - Jog

Configure an output variable from the controller for jogging the master axis.

When TRUE, the master axis is started in jog mode.
» Size: Indicates the data type of the variable (BOOL).
* Description: Enter a describing text.

« Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.
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With Motion > Control Mode > Velocity selected, you can right-click the master
axis in the Model view and run the commands Forward and Backward from the
contextual menu. The following Controller parameters are available:

Parameter

Description

Enable
Acceleration

Select the option to enable acceleration control and configure the following
parameters:

* Ramp Up: Enter the maximum time (in ms) to elapse until the master
axis has reached the configured Speed.

* Ramp Down: Enter the maximum time (in ms) to elapse until the master
axis has reached standstill.

PLC Output - Invert
Direction

Configure an output variable from the controller to invert the motion direction
of the master axis.

When TRUE, the default motion direction is inverted and motion is executed
in the negative direction.

« Size: Indicates the data type of the variable (BOOL).

+ Description: Enter a describing text.

+ Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.

PLC Output -
Velocity

Configure an output variable from the controller for the velocity (in deg/s) of
the master axis.

The default value is 10 degl/s.

» Size: Indicates the data type of the variable (LREAL).

» Description: Enter a describing text.

» Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.

Select the Position > Locked check box to lock the position of the master axis to
help prevent it from being moved within the scene.

The Visualization parameters allow you to configure programming code that is
executed when a selectable event is detected on the kinematic axis:

Parameter Description
Visible Clear the check box to hide the kinematic axis in the scene.
Color If the Visible check box is selected, select a color for the

master axis.
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Properties of a Cam Diagram

To customize a cam diagram you have added to your scene using the
Kinematization menu, select it in the Model view or in the Solution Explorer
view and configure your individual settings in the Properties view.

The Parent parameters allow you to select a drive type that is allowed by the
parent assembly of the cam diagram:

Parameter Description

Name Indicates the assembly that was selected when this cam diagram was
created with the Create Cam command. The field cannot be edited.
Example: Kinematic Axisl

Linked to Select the drive type that is allowed by the parent assembly from the list, for

example, Position for kinematic axes.

The Master Axis parameters allow you to link the cam diagram to a master axis:

Parameter Description

Name Click the arrow to display a list of master axes defined in your project. Select
the master axis to which you want to link your cam diagram. The motion of
the cam is then in accordance with the positions received from the selected
master axis.

Encoder Offset Enter an encoder offset of the cam diagram with reference to the master

axis.

Range: -360...360 °

The File parameter allows you to import a .asc file that you have created
beforehand with the Motion Sizer. For a detailed description of this file type, refer
to the Interpolated Profile File Format (.asc) chapter of the Motion Sizer Online

Help.
Parameter Description
Name Click the ... button to open an Import Cam Points File dialog box. Browse

to the .asc file you want to load, select it and click Open.
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The Configuration parameters allow you to configure the cam diagram

parameters.

Parameter

Description

Enabled

By default, the cam diagram is enabled. To disable, clear the check box.

Modulo Mode

By default, the option Modulo Mode is selected. This is suitable for cam
diagrams with the same start and end point because with every new curve,
the initial start point is used.

For cam diagrams where the start and the end point differ, clear this option
to avoid jumps in the simulation because the end point of the first curve is
used as the start point of the second curve and so on.

Header

Indicates the software information that is read from line 1 of the .asc file and
cannot be edited.

Example: Motion Sizer

Version

Indicates the version information that is read from line 2 of the .asc file and
cannot be edited.

Y Factor

Indicates the Y factor information that is read from line 3 of the .asc file.

Click the field to configure the length of motion on the y axis (in mm for
translational motion, in ° for rotational motion). The value must be greater
than 0.

X Factor

Indicates the X factor information that is read from line 4 of the .asc file.
Default value: 360 ° that corresponds to one full rotation of the master axis.
Click the field to configure the scale of the x axis that is used to determine

the x coordinate of the segment end point. The value must be greater than
0.

Y Offset

Indicates the y coordinate information of the start point of the cam segment
that is read from line 5 of the .asc file.

Click the field to enter an offset for the start point on the y axis (in mm for
translational motion, in ° for rotational motion).

X Offset

Indicates the x coordinate information of the start point of the cam segment
that is read from line 6 of the .asc file.

Click the field to enter an offset for the start point on the x axis (in mm for
translational motion, in ° for rotational motion).

The X Offset parameter corresponds to the Master Axis > Encoder Offset
parameter.

Start Slope

Indicates the slope of the position profile at the first point of the profile that is
read from line 7 of the .asc file and cannot be edited.

End Slope

Indicates the slope of the position profile at the last point of the profile that is
read from line 8 of the .asc file and cannot be edited.

Interpolation Mode

Indicates the interpolation mode that is read from line 9 of the .asc file and
cannot be edited.

* 0 =natural spline
» 1 =spline on base of the slope of the borders
* 2 =periodic spline

Cam Points

Indicates the [0]...[360] profile values that are read from lines 11 and the
following of the .asc file. The values cannot be edited.

For further information on the .asc file content, refer to the Interpolated Profile File
Format (.asc) chapter of the Motion Sizer Online Help
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Load Handling Menu

Commands of the Load Handling Menu

Sensors Section

The Load Handling menu is grouped in different sections:
* Sensors, page 50

* RFID, page 52

* TCP Tools, page 55

* Vision Systems, page 57

* Modifiers, page 59

* Feeders, page 61

* Observers, page 63

* Equipment Sensors, page 65

It allows you to create different components for load handling, such as sensors,
feeders, eaters, counters. By default, they are inserted at the center of the Model
view represented by the origin of the global coordinate system. If the value of the
Z coordinate of the global coordinate system is 0, an offset of 500 mm is added for
the new objects in Z direction to help avoid that they appear as if they were half
sunk into the floor.

The Sensor section allows you to create infrared sensors at the center of the
Model view represented by the origin of the global coordinate system detecting
the presence of load objects of the selected shape within the scene. When a
sensor is selected, its local coordinate system is displayed in the scene and its
properties are displayed in the Properties view, page 51.

Command Description

Rectangular Click to add a box-shaped sensor to the scene at the center of the Model view
represented by the origin of the global coordinate system.

When one or multiple assemblies are selected, one rectangular sensor is
created per assembly with the respective dimension and at the respective
position.

Cylindrical Click to add a cylinder-shaped sensor to the scene at the center of the Model
view represented by the origin of the global coordinate system.

When one or multiple assemblies are selected, one cylindrical sensor is created
per assembly with the respective dimension and at the respective position.

Spherical Click to add a sphere-shaped sensor to the scene at the center of the Model
view represented by the origin of the global coordinate system.

When one or multiple assemblies are selected, one spherical sensor is created
per assembly with the respective dimension and at the respective position.
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Properties of Sensors

To customize a sensor you have added to your scene using the Load Handling
menu, select it in the Model view and configure your settings in the Properties
view.

With the Geometry parameters, you can configure or modify the shape of the
sensor:

Parameter Description

Type Select the shape of your sensor and configure the corresponding sub
parameters. You can change the shape whenever required.

* Rectangular
° Length
o Height
o Width

* Cylindrical
o Length
° Radius

* Spherical

o Radius

With the Filter parameter, configure whether the sensor detects the presence of
load objects:

Parameter Description

Type Select from the list:

« Match (default setting): The sensor detects loads having an identifier
(usually a barcode) that exactly matches the string entered in the ID text
field below.

» Contains: The sensor detects loads having an identifier (usually a
barcode) that contains the string entered in the ID text field below (and
can contain more characters).

If the ID text field is empty, any kind of load object is detected.

ID By default, this field is empty and the presence of any kind of load object is
detected.

To restrict detection to specific loads, enter a string that must be available in
the Identification parameter of a load for detecting it.

Also refer to Information Provided in the Loads View, page 88.

With the PLC Input parameter, configure an input variable to the controller that is
set as soon as a load is detected by the sensor.

Parameter Description

Blocked » Size: Indicates the data type of the variable (BOOL).
« Description: Enter a describing text.

« Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.
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RFID Section

The RFID section allows you to create Radio Frequency Identification Devices
(RFID) of a shape to be configured with the Geometry parameters, page 51 within
the scene at the center of the Model view represented by the origin of the global
coordinate system. When an RFID is selected, its local coordinate system is
displayed in the scene and its properties are displayed in the Properties view.

Command

Description

RFID Reader

Click to add an RFID reader (for example, a barcode scanner) to the scene at
the center of the Model view represented by the origin of the global coordinate
system.

When one or multiple assemblies are selected, one RFID reader is created per
assembly with the respective dimension and at the respective position.

RFID Writer

Click to add an RFID writer (for example, a barcode writer) to the scene at the
center of the Model view represented by the origin of the global coordinate
system.

When one or multiple assemblies are selected, one RFID writer is created per
assembly with the respective dimension and at the respective position.
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Properties of RFI Devices

To customize an RFI device you have added to your scene using the Load
Handling menu, select it in the Model view and configure your settings in the

Properties view.

With the Filter parameters, configure whether the RFI device detects the
presence of load objects:

Parameter

Description

Type

Select from the list:

* Match (default setting): The RFI device detects loads having an identifier
(usually a barcode) that exactly matches the string entered in the ID text
field below.

+ Contains: The RFI device detects loads having an identifier (usually a
barcode) that contains the string entered in the ID text field below (and
can contain more characters).

If the ID text field is empty, any kind of load object is detected.

By default, this field is empty and any kind of load object is detected.

To restrict detection of specific loads, enter a string that must be available in
the Identification parameter of a load for detecting it.

Also refer to Information Provided in the Loads View, page 88.

With the PLC Input parameters, configure input variables to the controller that are
set as soon as a load or a barcode is detected by the RFI device.

Parameter

Description

Blocked

The following parameters indicate the presence of a load object to the
controller:

» Size: Indicates the data type of the variable (BOOL).
+ Description: Enter a describing text.

+ Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

Barcode

The following parameters provide the barcode (identification) of a load read
by the RFI device to the controller:

+ Size: Indicates the data type of the variable (STRING).
» Description: Enter a describing text.

+ Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

With the Behavior parameters, configure the relevant number of characters of the
barcode and enable and configure the writing mode.
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Parameter

Description

Barcode Length

By default, the number of barcode characters read by the RFI device is 12.
You can reduce the number of barcode characters transmitted by the PLC
Input > Barcode parameter to the controller if not the entire length but only
a reduced number of characters is relevant.

Enable Writing
Mode

Select the option for a barcode reader to extend it by writer functions. As a
result, the parameters Write Mode and Automatic Barcode are displayed
below.

Write Mode

Exclusive to barcode writers:

Select one of the following options:

* Automatic:
With this option selected, a new text field Automatic Barcode is
displayed. Enter a starting value in the Automatic Barcode field that is
written to the first load detected. For each load that is following, the value
is increased by one and assigned to the loads consecutively.

* Fixed:
With this option selected, a new text field Fixed Barcode is displayed.
Enter a fixed value in the Fixed Barcode field. This value without
modification is written to every load that is detected.

« Controller:
With this option selected, a new parameter Barcode is displayed in the
group of PLC Output parameters below.

With the PLC Output parameters, configure output variables from the controller
for the barcode writer.

Parameter

Description

Write Trigger

Exclusive to barcode writers:
When TRUE, the barcode is written to the load.

The following parameters trigger the barcode writing:
» Size: Indicates the data type of the variable (BOOL).
» Description: Enter a describing text.

» Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.

Barcode

Exclusive to barcode writers:

The following parameters generate a barcode (identification) that is written
to the load:

» Size: Indicates the data type of the variable (STRING).

» Description: Enter a describing text.

» Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.
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TCP Tools Section

The TCP Tools section provides commands for creating different kinds of grippers
as well as trajectory plotters of a shape to be configured with the Geometry
parameters, page 51 within the scene at the center of the Model view represented
by the origin of the global coordinate system. When a gripper is selected, its local
coordinate system is displayed in the scene and its properties are displayed in the
Properties view. To attach a gripper to a robot, right-click the robot and run the
command Tool Manager > Attach New Tool as described in the chapter
Managing Tools Within the Model View, page 77.

Command Description
Gripper Click to add a gripper to the scene at the center of the Model view represented
by the origin of the global coordinate system.
When one or multiple assemblies are selected, one gripper is created per
assembly with the respective dimension and at the respective position.
Delta Standard Click to add a default gripper provided for delta robots to the scene at the center
Gripper of the Model view represented by the origin of the global coordinate system.
Cobot Standard | Click to add a default gripper provided for the Lexium Cobot to the scene at the
Gripper center of the Model view represented by the origin of the global coordinate

system.

Scara Standard
Gripper

Click to add a default gripper provided for the Lexium SCARA Robot to the
scene at the center of the Model view represented by the origin of the global
coordinate system.

Gripper Click to add a gripper suppressor for detaching a load from a gripper to the
Suppressor scene at the center of the Model view represented by the origin of the global
coordinate system.
When one or multiple assemblies are selected, one gripper suppressor is
created per assembly with the respective dimension and at the respective
position.
Trajectory Select an assembly and click to add a trajectory plotter that displays trajectory
Plotter lines with the movement of the assembly. To configure the properties of the

trajectory plotter, refer to Properties of Trajectory Plotters, page 57.
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Properties of Grippers and Gripper Suppressors

To customize a gripper you have added to your scene using the Load Handling
menu, select it in the Model view and configure your settings in the Properties

view.

With the PLC Input parameters, configure input variables to the controller that are
set as soon as the presence of a load object is detected and a load has been
gripped by the gripper.

Parameter

Description

Blocked

The following parameters indicate the presence of a load object to the
controller:

« Size: Indicates the data type of the variable (BOOL).
» Description: Enter a describing text.

* Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

Disable

This controller signal is exclusive to gripper suppressors. When TRUE, the
gripper suppressor is deactivated. The following parameters deactivate the
gripper suppressor:

» Size: Indicates the data type of the variable (BOOL).
* Description: Enter a describing text.

» Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.

Load gripped

When TRUE, a load is attached to the gripper.

The following parameters indicate to the controller that a load has been
gripped and is attached to the gripper:

» Size: Indicates the data type of the variable (BOOL).

* Description: Enter a describing text.

» Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

With the Behavior parameters, configure a new position and orientation for the
load with reference to the center of the load when the gripper is activated.

Parameter

Description

Use Attach Offset

Select this option to configure an offset with reference to the center of the
load.

Position Enter the x, y, z coordinates (in mm) where the load is to be located when
the gripper is activated.

RotX Enter an angle (in °) of rotation of the load around the X coordinate.

RotY Enter an angle (in °) of rotation of the load around the Y coordinate.

RotZ Enter an angle (in °) of rotation of the load around the Z coordinate.

Visible Select this check box to display a local coordinate system at the position in

the scene that is defined with the offset parameters.

With the PLC Output parameter, configure the output variable from the controller
to activate the vacuum gripper.

Parameter

Description

Activate Vacuum

When TRUE, the vacuum gripper is activated.

The following parameters activate the vacuum gripper:
» Size: Indicates the data type of the variable (BOOL).
« Description: Enter a describing text.

« Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.

56

EI00000005022.05



Menu Bar

Getting Started

Properties of Trajectory Plotters

To customize a trajectory plotter you have added to an assembly using the Load
Handling menu, select the subnode Trajectory Plotter of the assembly in the
Solution Explorer view and configure your settings in the Properties view.

As a prerequisite for displaying trajectory lines, start the physical simulation.

Parameter Description
Visible Select this check box to enable trajectory plotting.
Color If the Visible check box is selected, select a color for the

trajectory lines.

Retention Time

Enter a time (in milliseconds) each trajectory line is visible in
the scene.

Default value: 2000 ms

Vision System Section

The Vision System section allows you to create sensors retrieving load
information regarding the position and orientation in space of a shape to be
configured with the Geometry parameters, page 51 within the scene at the center
of the Model view represented by the origin of the global coordinate system.
When a vision system is selected, its local coordinate system is displayed in the
scene and its properties are displayed in the Properties view.

Command

Description

Position

Click to add a vision system retrieving position information from the load to the
scene at the center of the Model view represented by the origin of the global
coordinate system.

When one or multiple assemblies are selected, one vision system is created per
assembly with the respective dimension and at the respective position.

Orientation

Click to add a vision system retrieving orientation information from the load to
the scene at the center of the Model view represented by the origin of the
global coordinate system.

When one or multiple assemblies are selected, one vision system is created per
assembly with the respective dimension and at the respective position.

Both

Click to add a vision system retrieving position and orientation information from
the load to the scene at the center of the Model view represented by the origin
of the global coordinate system.

When one or multiple assemblies are selected, one vision system is created per
assembly with the respective dimension and at the respective position.
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Properties of Vision Systems

To customize a vision system you have added to your scene using the Load
Handling menu, select it in the Model view and configure your settings in the

Properties view.

With the PLC Input parameters, configure input variables to the controller that are
set as soon as the presence of a load object is detected and that provide the
configured position and / or orientation information. The position and orientation is
relative to the origin of the sensor.

Parameter

Description

Blocked

The following parameters indicate the presence of a load object to the
controller:

» Size: Indicates the data type of the variable (BOOL).
« Description: Enter a describing text.

« Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

Position-X

The following parameters provide the position information concerning the X
axis of a load to the controller:

» Size: Indicates the data type of the variable (LREAL).
» Description: Enter a describing text.

* Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

Position-Y

The following parameters provide the position information concerning the Y
axis of a load to the controller:

» Size: Indicates the data type of the variable (LREAL).
« Description: Enter a describing text.

« Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

Position-Z

The following parameters provide the position information concerning the Z
axis of a load to the controller:

« Size: Indicates the data type of the variable (LREAL).
» Description: Enter a describing text.

» Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

Rotation-X

The following parameters provide the orientation information concerning the
X axis of a load to the controller:

» Size: Indicates the data type of the variable (LREAL).
* Description: Enter a describing text.

» Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

Rotation-Y

The following parameters provide the orientation information concerning the
Y axis of a load to the controller:

« Size: Indicates the data type of the variable (LREAL).
« Description: Enter a describing text.

» Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

Rotation-Z

The following parameters provide the orientation information concerning the
Z axis of a load to the controller:

» Size: Indicates the data type of the variable (LREAL).
* Description: Enter a describing text.

» Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

With the Behavior parameters, configure the information that is retrieved from the

load.
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Modifiers Section

Parameter

Description

Spatial Description | Select one of the following options to modify the information the vision

system retrieves from the load:

+ Position:
With this option selected, position information is retrieved from the load.

+ Orientation:
With this option selected, orientation information is retrieved from the
load.

* Pose:
With this option selected, position and orientation information is retrieved
from the load.

The Modifiers section allows you to create objects modifying the size, color,
position or the orientation of the load information of a shape to be configured with
the Geometry parameters, page 51 within the scene at the center of the Model
view represented by the origin of the global coordinate system. When a size or
color modifier is selected, its local coordinate system is displayed in the scene and
its properties are displayed in the Properties view.

Command

Description

Size

Click to add a sensor modifying the size of detected loads to the scene at the
center of the Model view represented by the origin of the global coordinate
system.

When one or multiple assemblies are selected, one vision sensor is created per
assembly with the respective dimension and at the respective position.

Color

Click to add a sensor modifying the color of detected loads to the scene at the
center of the Model view represented by the origin of the global coordinate
system.

When one or multiple assemblies are selected, one vision sensor is created per
assembly with the respective dimension and at the respective position.

Position

Click to add a sensor modifying the position of detected loads to the scene at
the center of the Model view represented by the origin of the global coordinate
system.

When one or multiple assemblies are selected, one vision sensor is created per
assembly with the respective dimension and at the respective position.

Orientation

Click to add a sensor modifying the orientation of detected loads to the scene at
the center of the Model view represented by the origin of the global coordinate
system.

When one or multiple assemblies are selected, one vision sensor is created per
assembly with the respective dimension and at the respective position.
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Properties of Modifiers

To customize a modifier you have added to your scene using the Load Handling
menu, select it in the Model view and configure your settings in the Properties

view.

With the PLC Input parameter, configure the input variable to the controller that is
set as soon as the presence of a load object is detected.

Parameter

Description

Blocked

The following parameters indicate the presence of a load object to the
controller:

» Size: Indicates the data type of the variable (BOOL).
» Description: Enter a describing text.

* Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

With the Load Parameters, configure the new target dimensions, color, or
position that are assigned by the modifier to the loads.

Parameter Description
Length Exclusive to size modifiers:

Enter the new target length that is assigned to the load (in mm).
Height Exclusive to size modifiers:

Enter the new target height that is assigned to the load (in mm).
Width Exclusive to size modifiers:

Enter the new target width that is assigned to the load (in mm).
Radius Exclusive to size modifiers:

Enter the new target radius that is assigned to the load (in mm).
Color Exclusive to color modifiers:

Click to open the color palette and select a color that is assigned to the load.

Relative Position

Exclusive to position modifiers:

Edit the X, Y, and / or Z coordinate to modify the relative position that is
assigned to the load.

Default value: 0:0:0 mm

RotX Exclusive to orientation modifiers:

Enter a rotation angle in ° around the X axis that is assigned to the load.
RotY Exclusive to orientation modifiers:

Enter a rotation angle in ° around the Y axis that is assigned to the load.
RotZ Exclusive to orientation modifiers:

Enter a rotation angle in ° around the Z axis that is assigned to the load.

With the PLC Output parameter, configure the output variable from the controller
to deactivate the modifier.

Parameter

Description

Disable

When TRUE, the modifier is deactivated.

The following parameters deactivate the modifier:
» Size: Indicates the data type of the variable (BOOL).
« Description: Enter a describing text.

» Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.
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Feeders Section

The Feeders section allows you to create feeders that add loads to your scene.
For general information on feeders, refer to Feeders, Loads and Eaters in the
EcoStruxure Machine Expert Twin How to Use Device Catalogs User Guide.

Command Description
Standard Click to add a generic (herein standard) feeder assembly to the scene at the
Feeder center of the Model view represented by the origin of the global coordinate

system. The standard feeder can create different types of predefined loads.

Custom Feeder | Select a body assembly or a container assembly and click to add a customized
feeder. The feeder is placed within the scene using the position and orientation
of the selected prototype body assembly. When it is selected, its local
coordinate system is displayed in the scene and its properties are displayed in
the Properties view.

As a prototype for the loads that are created by the customized feeder, you can
use a body assembly that has been created by importing a CAD file to
EcoStruxure Machine Expert Twin as explained in Importing a CAD File, page
37. For using it as feeder prototype, you can import the CAD file as one
assembly or as individual assemblies depending on the intended use.

Properties of Customized Feeders

To configure a Custom Feeder you have added to your scene using the Load
Handling menu, select it in the Model view and configure your settings in the
Properties view.

The Load parameters indicate the body assembly that is used as a base for the
loads to be generated and allow further configurations. This chapter only explains
the properties that are specific to customized feeders. For general properties,
refer to Feeders, Loads and Eaters in the EcoStruxure Machine Expert Twin How
to Use Device Catalogs User Guide
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Parameter

Description

Custom Load

Indicates the name of the body assembly that is used as a base for the

Assembly loads that are generated. This base cannot be modified. To use a different
body assembly as base, create another custom load feeder.
Rigid Defines the collider geometry used by the physical simulation.

« Box
Select this option to create new loads as simple, rigid boxes.
« Convex

Select this option to create new loads with a more accurate collider
geometry.

If the CAD file of the body assembly that is used as a base for the loads had been
imported as several assemblies (see Importing a CAD File, page 37), each load
that is generated also consists of several body assemblies. For each body
assembly that constitutes the load, an individual geometry is created. The
accuracy of the collider geometry of each body assembly depends on the option
selected for the Rigid parameter.

The following figures illustrate the differences for CAD files imported as single or
as multiple body assembly with Rigid > Box and Rigid > Convex selected and
with the convex mesh displayed in the scene (activated by running Level >
Detailed from the Debug section of the View menu, page 25).

Rigid option selected CAD file imported as single body CAD file imported as multiple body
assembly assembly

Box

Convex
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Observers Section

The Observers section allows you to create eaters, counters and weight scales of
a shape to be configured with the Geometry parameters, page 51 at the center of
the Model view represented by the origin of the global coordinate system. When
an eater, counter or weight scale is selected, its local coordinate system is
displayed in the scene and its properties are displayed in the Properties view.

Command

Description

Eater

Click to add an eater removing detected loads from the scene at the center of
the Model view represented by the origin of the global coordinate system.

When one or multiple assemblies are selected, one eater is created per
assembly with the respective dimension and at the respective position.

Counter

Click to add a counter counting detected loads at the center of the Model view
represented by the origin of the global coordinate system.

When one or multiple assemblies are selected, one counter is created per
assembly with the respective dimension and at the respective position.

Weight Scale

Click to add a weight scale to the scene at the center of the Model view
represented by the origin of the global coordinate system.

When one or multiple assemblies are selected, one weight scale is created per
assembly with the respective dimension and at the respective position.
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Properties of Observers

To customize an observer you have added to your scene using the Load
Handling menu, select it in the Model view and configure your settings in the

Properties view.

With the PLC Input parameter, configure the input variables to the controller that
are set as soon as the presence of a load object is detected.

Parameter

Description

Blocked

The following parameters indicate the presence of a load object to the
controller:

.

Size: Indicates the data type of the variable (BOOL).
Description: Enter a describing text.

Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

Counter

The following parameters are used for counting the number of loads that
have been deleted by the eater or that have been detected by the counter:

Size: Indicates the data type of the variable (INT).
Description: Enter a describing text.

Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

Weight

Exclusive to weight scales:

The following parameters provide the weight of the load (in kg) measured by
the sensor to the controller:

Size: Indicates the data type of the variable (REAL).
Description: Enter a describing text.

Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.

With the PLC Output parameters, configure the output variables from the
controller for counting and deactivating the observers.

Parameter

Description

Disable

When TRUE, the observer is deactivated.

The following parameters deactivate the observer:

Size: Indicates the data type of the variable (BOOL).
Description: Enter a describing text.

Symbol: Select the output variable of the controller. The list is provided
when a connection to the controller is established.
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Equipment Sensor Section

The Equipment Sensor section allows you to create sensors that detect the
presence of static objects or equipment (such as conveyors) at the center of the
Model view represented by the origin of the global coordinate system. When an
equipment sensor is selected, its local coordinate system is displayed in the scene
and its properties are displayed in the Properties view.

Command Description

Rectangular Click to add a box-shaped equipment sensor to the scene at the center of the
Model view represented by the origin of the global coordinate system.

When one or multiple assemblies are selected, one rectangular sensor is
created per assembly with the respective dimension and at the respective
position.

Cylindrical Click to add a cylinder-shaped equipment sensor to the scene at the center of
the Model view represented by the origin of the global coordinate system.

When one or multiple assemblies are selected, one cylindrical sensor is created
per assembly with the respective dimension and at the respective position.

Spherical Click to add a sphere-shaped equipment sensor to the scene at the center of
the Model view represented by the origin of the global coordinate system.

When one or multiple assemblies are selected, one spherical sensor is created
per assembly with the respective dimension and at the respective position.

Properties of Equipment Sensors

To customize an equipment sensor you have added to your scene using the Load
Handling menu, select it in the Model view and configure your settings in the
Properties view.

With the Geometry parameters, you can configure or modify the shape of the
sensor:

Parameter Description

Type Select the shape of your sensor and configure the corresponding sub
parameters. You can change the shape whenever required.

* Rectangular
° Length
o Height
o Width

* Cylindrical
o Length
> Radius

» Spherical
° Radius

With the PLC Input parameter, configure the input variable to the controller that is
set as soon as the presence of static objects is detected.

Parameter Description
Blocked The following parameters indicate the presence of a static object to the
controller:

» Size: Indicates the data type of the variable (BOOL).
« Description: Enter a describing text.

+ Symbol: Select the input variable of the controller. The list is provided
when a connection to the controller is established.
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SmartVisu Menu

General Information

The SmartVisu menu allows you to generate a 3-D digital twin of the machine you
configured with the DigitalTwinCommunication library in EcoStruxure Machine
Expert. For further information, refer to the DigitalTwinCommunication Library
Guide.

As a prerequisite, an OPC UA connection to a PacDrive LMC or a Modicon M262
Motion Controller must be established. For further information on creating an OPC
UA connection, refer to the Communication User Guide.

Elements of the SmartVisu Menu

Element Description

Connection ID Select the OPC UA connection to the desired controller for which you want
to create a 3-D digital twin.

Generate Reads the settings made in the DigitalTwinCommunication library and
displays a 3-D digital twin of your machine in the Model view.

NOTE:

The connection from EcoStruxure Machine Expert Twin to the
controller is using a handshake mechanism to acknowledge that event
data was received and ensure consistent information is displayed in
the Model view (single-instance mode).

In the case of multiple connections from EcoStruxure Machine Expert
Twin to the same controller, the primary connection is verifying the
data exchange by the handshake mechanism. Further connections
are working in multi-instance mode, and can process event data
simultaneously, but the handshake mechanism is not used for multiple
connections.

In few cases, under high usage of the communication bandwidth, full
transmission of events may not be possible, and might result in events
not being displayed in the instances using multi-instance mode.

Remove Removes the assemblies and loads generated from this connection from
the Model view.
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Managing Projects with SmartVisu Assemblies

It is possible to use different SmartVisu assemblies in the same EcoStruxure
Machine Expert Twin project. To add two SmartVisu assemblies to a project,
proceed as follows:

Step

Action

1

Establish an OPC UA connection to a PacDrive LMC or a Modicon M262 Motion
Controller.

For further information on creating an OPC UA connection, refer to the Communication
User Guide.

From the SmartVisu > Connection ID list, select the entry corresponding to the
connection that has the Status = Connected in the Connections view, page 70, for
example, Connection1.

Click the SmartVisu > Generate command.

Results:

» The 3-D digital twin of the Connection1 machine is displayed at the center of the
Model view.

* A new subnode SmartVisu [000 - Connection1] is added to the Assemblies node
of the Solution Explorer view, page 97.

Select the SmartVisu [000 - Connection1] node and edit the Transformation >
Position value to move the section from the center before you insert the second
SmartVisu section.

Establish a second OPC UA connection to a PacDrive LMC or a Modicon M262 Motion
Controller.

From the SmartVisu > Connection ID list, select the entry corresponding to this
second connection that also has the Status = Connected in the Connections view,
page 70, for example, Connection2.

Click the SmartVisu > Generate command.

Results:

» The 3-D digital twin of the Connection2 machine is displayed at the center of the
Model view.

* A new subnode SmartVisu [001 - Connection2] is added to the Assemblies node
of the Solution Explorer view, page 97.

To save the two SmartVisu sections to a project, run the File > Save As command,
browse to a folder, enter a file name and click Save.

You can open and edit projects that contain SmartVisu assemblies without the
OPC UA connection being established. When you attempt to establish the
connection after the SmartVisu assemblies have been modified, a SmartVisu
dialog box is displayed indicating the changes. It allows you to reload the
SmartVisu configuration from the DigitalTwinCommunication library in
EcoStruxure Machine Expert. This overrides the modifications you performed on
the project.

NOTE: Verify the modifications that are listed in the SmartVisu dialog box. To
prevent the modifications from being overwritten, click No and save the project
with a new name.
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Auto-Generation Menu

Commands of the Auto-Generation Menu

The Auto-Generation menu allows you to read the configuration of a multi carrier,
a robot or a servo belt and to create the corresponding assemblies after having
established a connection to the controller. As a prerequisite, the IP address and
the connection parameters must be configured correctly and an OPC UA
connection must be established. For further information on the prerequisites, refer

to:

* The Procedure for Starting the Emulation in the How to Emulate User Guide of
the EcoStruxure Machine Expert online help.

» The description of Creating Emulation Data in the Lexium™ MC multi carrier
Configuration Guide of the EcoStruxure Machine Expert online help.

The menu is grouped in different sections:

multi carrier Section

Command

Description

Name

Enter the name of the multi carrier object to be generated, for example, MC
Track 1.

Connection ID

Select the Connection ID from the list in accordance with the Connections
view, page 70.

Configure Data

Click this button to see the input and output data that is exchanged cyclically
between EcoStruxure Machine Expert Twin and the controller. In order to
optimize controller performance, you can activate or deactivate the exchange of
information as required in your application:

« Carrier Trackld

By default, the unique track ID is retrieved from the controller with the carrier
information.

« Carrier Product Color

By default, the color of the product is retrieved from the controller with the
carrier information.

» Carrier Collision Detection
By default, collision detection information is transmitted to the controller.
* multi carrier Error Display

By default, information on detected error states of carriers and segments is
not retrieved from the controller.

Load Object

Click to establish a connection to the configured controller and to read the
configuration of the multi carrier.

You can also click the button to update the created assemblies after you have
modified the configuration of the multi carrier.

Robots Section

Command

Description

Name

Enter the name of the robot object to be generated, for example, T Robot 1.

Connection ID

Select the Connection ID from the list in accordance with the Connections
view, page 70.

Load Object

Click to establish a connection to the configured controller and to read the
configuration of the robot.

You can also click the button to update the created assemblies after you have
modified the configuration of the robot.
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Servo Belts Section

Command

Description

Name

Enter the name of the servo belt object to be generated, for example, Infeed
Belt.

Connection ID

Select the Connection ID from the list in accordance with the Connections
view, page 70.

Load Object

Click to establish a connection to the configured controller and to read the
configuration of the servo belt.

You can also click the button to update the created assemblies after you have
modified the configuration of the servo belt.
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Connections View

Creating Connections

The Connections view allows you to create connections to your controllers or
higher level systems. By default, the view is empty. Right-click within the view to
open the Communication dialog box for selecting the communication protocol for
your connection.

Select a communication protocol and an entry will be displayed in the
Connections view for this connection.

By default, the following communication protocols are supported:

Address-based communication protocols:

+ Siemens

* Modbus

+ Serial (Raw)
+ XCom

Tag-based communication protocols:

+ Beckhoff ADS

+ Ethernet/IP - CIP Browsable

+ OPC UA Client

Messages-based communication protocols:

+ STC/IETX
+ 3964R
+ RFC 1006
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Configuring Connections

For a detailed description on how to configure an OPC UA connection, refer to the
EcoStruxure Machine Expert Twin How to Use Device Catalogs User Guide.

In general, configure a connection in two steps:

1. Select the row in the list of the Connections view and configure the
corresponding settings in the Properties view.

2. Right-click the row in the list of the Connections view to open the contextual
menu providing the following commands, depending on the connection type:

Command

Description

Connect All / Disconnect
All

Connects / disconnects all controllers simultaneously providing you
have entered an IP address for each connection.

Connect/ Disconnect

Connects to / disconnects from the selected controller.

Listen / Disconnect

Listens to / disconnects from the selected server.

The communication protocols RFC 1006 and 3964R TCP/IP can act
as server or client depending on the configuration in the Properties
view.

Enable Logging

Logs the messages sent by the controller and displays them in the
Logs view, page 86.

Truncate Log

If logging is enabled on the controller, text files (*.txt) are created in
your local Windows user directory:

%localappdata%\Schneider Electric\Machine Expert Twin\1\Work
\Logs

The log files are updated when the project is closed.

With this option selected, the log files are cleared when the project is
opened.

Import Imports the addresses from an Excel file to the controller.

Export Exports the addresses from the controller to an Excel file.

Alarms Opens the Alarm Scheme dialog box that allows you to set alarms
and which error messages they will display. For further information,
refer to the description of the Alarm Scheme Dialog Box, page 71.

Delete Deletes the connection.

Alarm Scheme Dialog Box

In the Connections section, right-click on a connection and select Alarms to
display the Alarms Scheme dialog box.

Column Description

Subscribe Select whether or not the alarm is activated.

. Address These parameters define the address of the alarm.
+ Bit

* Source

Description Enter the description for the alarm.

If the data exchange to the controller is address-based, add alarms when the
controller is not connected. If the data exchange is tag-based, add alarms when
the controller is connected. Also refer to the description of the Alarms view, page

90.

EI00000005022.05

7




Getting Started Catalogs View

Catalogs View

What’s in This Chapter

Catalogs VIEW .. oo 72

Catalogs View

General Information

The Catalogs view displays the catalogs that have been selected during start-up
of EcoStruxure Machine Expert Twin in the Select Catalog(s) dialog box.

Catalogs are handled as DLL files that are by default provided in the EcoStruxure
Machine Expert Twin installation folder. The default catalogs are extended by the
prefix Experior. Catalog, for example Experior.Catalog.SchneiderElectric.
Accessories.dll.

Catalogs function as a form of libraries that provide different assemblies and other
items. You can also create your own catalogs using the C# programming
language. To reference your own catalogs, click the browse (...) button in this
dialog box and browse to the folder that contains your catalogs.

Selecting Objects from Catalogs

The Catalogs view displays the catalogs you selected in the Select Catalog(s)
dialog box either in a Gallery View Style or in a Tree View Style. Select a catalog
to see the objects it contains. To use an object in your scene, select the object,
position the cursor in the Model view and click to place the object.

If the Gallery View Style is selected, objects you insert consecutively are
automatically connected. For example, you can insert different types of conveyors
consecutively by double-clicking the conveyor objects in the Belts & Conveyors
catalog. As a result, each new conveyor is snapped to the end of the last conveyor
extending the line of conveyors.

For further information, refer to the EcoStruxure Machine Expert Twin How to Use
Device Catalogs User Guide.
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Control Panel View

Creating Controls

The Control Panel view allows you to insert controls for communicating with the
controller. Right-click on an empty square of the Control Panel view to open a
contextual menu that provides different types of controls:
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The Buttons work when you press them while the Lamps light up when a specific
controller signal is sent.

The Knob allows you to switch between different values which you can select in
the Properties view.

The Gauge displays values sent from the controller.

The Switches option allows you to choose between two-state and three-state
switches.

After you have selected a control, you can edit the properties in the Properties
view such as name and color.
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Copying / Pasting / Removing Controls
To copy a control, right-click it in the Controls (n) tab and run the command Copy
from the contextual menu.

Right-click in the Controls (n) tab and run the command Paste to insert the
control you copied.

To remove a control, right-click it in the Controls (n) tab and run the command
Delete from the contextual menu.

Managing Control Panel Tabs

To manage the tabs of the Control Panel view, right-click the header of a
Controls (n) tab. A contextual menu with the following commands is displayed:

Command Description

Left / Right Allows you to move a Controls (n) tab to the left, to the right, to the first or to
the last position.
First/ Last

New Control Panel | Creates a new Controls (n+1) tab and inserts it at the right end.

Duplicate (tab Copies the active tab with its content and inserts it as new tab with tab name
name) Copy of (tab name) to the right of the existing tabs.

Delete (tab name) Deletes the active tab.

Delete All Deletes all tabs. As a result, the two empty default tabs Controls (1) and
Controls (2) are provided.

Undock Allows you to move the selected tab to another position in the EcoStruxure
Machine Expert Twin screen.

Alignment Allows you to display the tab headings not at the Top of the Control Panel
view, as it is by default, but at the Bottom, the Left or the Right of the view.
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The Model view is where you display your scene and its constituent assemblies
and loads. You can also graphically visualize what happens when you play the
scene.

The three arrows in the middle represent the 3-D coordinate system of the Model
view using the colors X =red, Y = green, Z = blue. For further information, refer to
Information About the Coordinate System, page 17.

Zooming, Rotating, Moving the Camera View

To zoom the camera view within the Model view, scroll the mouse wheel or set the
zoom shortcuts in the Settings menu, page 26.

To rotate the camera view, hold down the left mouse button, and move the mouse.

To move the camera view, hold down the right mouse button, and move the
mouse.

Rotating Objects in the Scene

Sections

Select an object in the Model view and perform the following mouse actions for
rotation around the different axes:

Mouse Action Rotation around axis
Scroll the mouse wheel 4
Hold down the Ctrl key and scroll the mouse wheel Y
Hold down the Alt key and scroll the mouse wheel X

By default, the Model view contains one section. The section is the container of
assemblies inside a scene. The default section has a size of 50,000 mm x 50,000
mm and can be modified in the Properties view. The floor of the section is
displayed gray by default but if you flip the scene to see it from below the floor
appears transparent. In the Properties view, the floor can be modified regarding
color and type.
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Adding Sections

To add sections to the Model view, proceed as follows:

Step Action

1 In the Solution Explorer view, right-click the Assemblies node and run the command
Add Section from the contextual menu.

Results:

* Inthe Solution Explorer view, a new node Section[n+1] is added below the last
section node.

* Inthe Model view, a new section is displayed on top of the existing section. Unless
you changed the dimensions or the position of the existing section you will not be
able to see the new section immediately as it is directly on top of the existing.

2 In the Solution Explorer view, select the node of the new section, to make it active.

Result: Further information on the section is displayed in the Properties view.

Modifying the Floor Using the Section Properties

You can modify what is displayed as the floor in the Model view by modifying the
properties of the section. Proceed as follows:

Step Action

1 In the Solution Explorer view, expand the Assemblies node and select the Section
node.
2 In the Properties view, modify the properties.

» With the parameter Section > Name you can assign a name to the section that
is displayed at the lower right corner of the floor in the Model view.

« To hide the selected section from the Model view, clear the check box Visible.

« Enter the Size > Width and Size > Length of your choice to modify the size of
the section.

« Enter the Transformation > Position > 0:0:0 mm and / or the
Transformation > Yaw (in °) to modify the position of the section in space (in a
cartesian coordinate system).

» Select an option from Assemblies to move, lock, enable or select assemblies
in the selected section.

« Select another option from Floor > Type to modify, for example, the color or
the texture of the section displayed as floor.

* In Grid, you can, for example, hide the grid and enable bounds or you can
import a floor design of your choice by selecting the option AutoCAD and
importing a *.dxf or *.dwg file.

The properties defined here are specific to the selected section. When you open a
new Model view, a default section with the default settings opens.
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Status Bar

The status bar at the bottom of the Model view displays information about the

scene:

Column

Description

Paused / Running

Indicates if the time is running (the scene is playing) or paused.

Scan Indicates the time (in ms) it took to calculate the last step of the physical
simulation. If this number becomes too high, an advisory message will be
displayed on the right-hand side of this status bar.

Lock icon Indicates whether the scene is locked.

Time displayed as
[dd:hh:mm:ss]

Displays the time elapsed while playing the scene.

Time scale

Displays the time scale for playing the scene, such as:
1 =real time
2 = double real time

The maximum is 10 times real time.

Information and
diagnostic
messages

Provides information and advisory messages that are relevant while playing
the scene. The messages are color-coded according to the severity. For
information on messages provided in the Logs view, refer to the chapter
Logs View, page 86.

Managing Tools Within the Model View

Overview

You can attach or detach tools to or from assemblies that are available in the
Model view by using the Tool Manager. To access the function, right-click the
assembly in the Model view and run the command Tool Manager from the

contextual menu.

The following assembly types are supported:

e Lexium Cobot

* Lexium SCARA Robot

* Delta robots

» Carriers of a Lexium™ MC multi carrier track

You can attach tools that are available in EcoStruxure Machine Expert Twin or that
you create using the Kinematization menu, page 33.
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Attaching a Tool to an Assembly

To attach a tool to an assembily, right-click the assembly in the Model view and run
one of the following commands from the Tool Manager contextual menu:

* Tool Manager > Attach Existing Tool to attach a tool that is available in the
scene but not attached to an assembly.

+ Tool Manager > Attach New Tool to attach a new tool in two different ways:

o

o

Select Tool Manager > Attach New Tool > Custom Tool to attach a
container assembly that you create with the Tool Container command of
the Kinematization menu, page 42.

Attach a tool that is available by default, for example, by running Tool
Manager > Attach New Tool > Cobot Standard Gripper to attach the
default gripper provided for the Lexium Cobot or Tool Manager > Attach
New Tool > Delta Standard Gripper to attach the default gripper provided
for delta robots.

Attaching a New Tool to an Assembly

To attach a new tool that is provided by default by EcoStruxure Machine Expert
Twin, proceed as described in this example for attaching the Cobot Standard
Gripper to a Lexium Cobot:

Step

Action

1

Select an object in the Cobot catalog and add it to the Model view.

2

Right-click the Cobot assembly in the Model view and run the command Tool Manager
> Attach New Tool > Cobot Standard Gripper from the contextual menu.

Result: The tool is attached to the Cobot assembly in the Model view and is displayed
in the Solution Explorer view as subnode Cobot Standard Gripper of the Cobot node.

Select the node Cobot Standard Gripper and subnodes Vacuum Actuator, Vacuum
Sensor in the Solution Explorer view to configure the properties of the gripper in the
Properties view according to your individual requirements.

Attaching a New Customized Tool to an Assembly

You can attach a tool container that you create with the Tool Container command
of the Kinematization menu, page 42 as follows:

Step

Action

1

Right-click an assembly in the Model view and run the command Tool Manager >
Attach New Tool > Custom Tool from the contextual menu.

Result: A small black cube is displayed at the assembly in the Model view and in the
Solution Explorer view, a new subnode Custom Tool including another subnode
Kinematization Root is added to the node of the selected assembly.

Select the subnode Kinematization Root, open the Kinematization menu and attach
body assemblies or container assemblies as described in Kinematization Menu, page
33.

Result: The body assemblies or container assemblies are attached as a tool to the
selected assembly and are displayed as subnodes of the Kinematization Root in the
Solution Explorer view. This relationship as well as the Kinematization container
assembly itself is saved with the .Experior project and is preserved when the project is
closed and reopened.

Attaching an Existing Tool to an Assembly

To attach a tool that is available in the scene, proceed as follows:

78
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Step Action

1 Right-click an assembly in the Model view and run the command Tool Manager >
Attach Existing Tool from the contextual menu.

Result: The tools and tool containers that are available in the scene but not attached to
an assembly are provided for selection.

2 Select the tool you want to attach.

Result: A message is displayed requesting to you to decide whether you want to
preserve the position and orientation of the tool with respect to the assembly. Proceed
with step 3a clicking Yes or with step 3b by clicking No.

3a Click Yes to preserve the position and orientation of the tool with respect to the
assembly.

Result: The tool is attached to the assembly without changing its position or orientation
in the Model view but with an offset to the assembly. This offset is preserved and the
tool is moved in accordance with the assembly changing position and or orientation
within the scene.

3b Click No to attach the tool to the assembly.
Result: The tool is moved within the scene and attached to the assembly.

Use the Properties > Offsets Relative to Flange parameters to adjust the orientation
of the tool relative to the assembly.

Detaching a Tool from an Assembly

To detach a tool from an assembly, proceed analog to the example for attaching a
cubic gripper to a Lexium Cobot:

Right-click the Cobot assembly in the Model view and run the command Tool
Manager > Detach Active Tool(Experior.Catalog.Schneider.Electric.Cobots.
CubicGripper) from the contextual menu.

This results in two separate stand-alone assemblies indicated in the Model view
and in the Solution Explorer view:

» The Cobot assembly
* The gripper assembly

When you detach a Kinematization container assembly from an assembly, the
Kinematization container assembly is preserved as stand-alone in the scene and
is displayed in the Solution Explorer view as a separate Kinematization Root[n]
node.

Preparing a Kinematization Chain for Use as Kinematization Tool

To create a kinematization chain with the Kinematization menu and to prepare it
for use as kinematization tool, proceed as follows:
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Step

Action

Create a kinematization chain by creating body assemblies and / or kinematic axes
using the Kinematization menu, selecting them in the scene or in the Solution
Explorer by holding down the Ctrl key and clicking the Attach button from the
Kinematization menu.

Result: A node for this kinematization chain is created in the Solution Explorer view.

Click the Create button in the Kinematization menu to create a container assembly as
described in the Assembly Section of the Kinematization Menu, page 42.

Result: An Assembly node is created in the Solution Explorer view for this empty
container assembly.

Select the Assembly node in the Solution Explorer, hold down the Ctrl key, select the
node of the kinematization chain and click the Attach button from the Kinematization
menu.

Result: The kinematization chain is grouped within the container assembly and
displayed as subnode of the Assembly node in the Solution Explorer.

Attaching a Kinematization Chain to an Assembly

To attach a kinematization chain that is available as a container assembly as
described in Preparing a Kinematization Chain for Use as Kinematization Tool,
page 79, proceed as follows:

Step

Action

1

Right-click an assembly, for example, a Lexium Cobot, in the Model view and run the
command Tool Manager > Attach Existing Tool > Use Existing Kinematization.

Result: The container assemblies that are available in the scene but not attached to an
assembly are provided for selection.

Select the suitable container assembly Assembly[n] from the contextual menu.

Result: A message is displayed requesting to you to decide whether you want to
preserve the position and orientation of the container assembly with respect to the
assembly. Proceed with step 3a clicking Yes or with step 3b by clicking No.

3a

Click Yes to preserve the position and orientation of the container assembly with respect
to the assembly.

Result: The container assembly is attached to the assembly without changing its
position or orientation in the Model view but with an offset to the assembly. This offset is
preserved and the container assembly is moved in accordance with the assembly
changing position and or orientation within the scene.

3b

Click No to attach the container assembly to the assembly.

Result: The container assembly is moved within the scene and attached to the
assembly.

Use the Properties > Offsets Relative to Flange parameters to adjust the orientation
of the tool relative to the assembly.

A new node Kinematized Tool - [n] is displayed as subnode of the assembly, for
example, the Lexium Cobot. The Kinematized Tool - [n] node provides the
container assembly including the kinematization chain as subnode.
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Managing Measurements Within the Model View

Overview

You can retrieve precise information about the position and orientation of body
assemblies and joints that are available in the Model view by using the
Measurements Manager. The position and orientation values are retrievable
related to the global coordinate system or related to any other freely selectable
object in the scene. With the plotting capability, the values of the position and
orientation can be traced over time.

To access the function, right-click the body assembly in the Model view and run
the command Measurements Handler from the contextual menu.

Commands of the Measurements Handler

Right-click the body assembly in the Model view to open the Measurements
Handler contextual menu with the following commands:

Command Description

Enable / Disable Measurements Run this command to enable or disable the measuring
function for the selected body assembly.

By default, the function is disabled.

Measurements The command is available after the function has been
enabled with the Enable Measurements command. It allows
you to retrieve position and orientation values of the selected
body assembly relative to the global coordinate system or to
another freely selectable object in the scene as well as
plotting them to a graph with the following subcommands.

Add New Run the command and select the reference for the
Measurement measurement:
Relative To

* Global Coordinate System

* [name of body assembly available in the Model view
with measurements function enabled], for example,
Cylinder

Result: The Measurand Selector dialog box is displayed,
page 82.

Existing After you have selected one or more measurands in the
Measurements | Measurand Selector dialog box, page 82, the selected
measurands are available for selection with this
subcommand and can be activated for plotting.

Example:

Measurements > Existing Measurements > PositionX >
Plot

Result: An individual Measurand Plotter view opens for
each measurand that you select, page 83.

Export Multiple The Export Multiple Measurements command allows you
Measurements to export the values of measurands that were selected with
the Measurand Selector dialog box to a .csv file.

Run the command to open the Multi Measurand Exporter
dialog box, page 84.
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Measurand Selector Dialog Box

The Measurand Selector dialog box opens when you have selected the
reference for the measurement with the Measurements > Add New
Measurement Relative To command. It allows you to select the measurands that
will be measured for the selected body assembly.

Select one or more of the following position or orientation measurands:
+ Position Measurands: PositionX, PositionY or PositionZ

+ Orientation Measurands: RotX, RotY or RotZ

Click OK to confirm the selection.

Wi and Selector n

on Meatgrpnds
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Measurand Plotter View

A Measurand Plotter view is displayed for each measurand selected with
Measurements > Existing Measurements > [position or orientation

measurand] > Plot.

Each Measurand Plotter view displays the values of the selected measurand (for
example, PositionX in mm or RotationZ in degrees) of the selected body
assembly (for example, Box) related to the reference (for example, Global
Coordinate System) over time in a coordinate system when the physical
simulation is enabled and the scene is played.

The Measurand Plotter view can also display scalar variables of FMU blocks
(also refer to FMI Menu, page 31).

The following options are available:

Option Description
Enable By default, the Enable Autoscaling check box is selected and the graph is
Autoscaling displayed within the given size of the Measurand Plotter view.

When you scroll the mouse wheel to zoom in or out of the view, the Enable
Autoscaling check box is automatically cleared and zooming in or out of the
graph is performed at the cursor position. When you keep the right mouse
button pressed and move the mouse up and down or left and right, you can
move the complete graph within the window.

To display the graph evenly within the Measurand Plotter view, select the
Enable Autoscaling check box again.

Always on Top

By default, the Always on Top check box is selected to display the
Measurand Plotter view in front of the EcoStruxure Machine Expert Twin
window.

When you clear the check box, the view is moved to the background when
you click within the EcoStruxure Machine Expert Twin window.

Click a position
within the graph

Result: The value of the measurand at the selected point in time is indicated
in a yellow box.
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Multi Measurand Exporter Dialog Box

Run the Export Multiple Measurements command to open the Multi Measurand
Exporter dialog box. It lists the measurands that were selected with the
Measurand Selector dialog box.

The Multi Measurand Exporter dialog box can also display the selected scalar
variables of FMU blocks (also refer to FMI Menu, page 31).

To select measurands for export to a .csv file, proceed as follows:

Step Action

1 Select the check boxes of one or more measurands to export.

2 Select one of the Export Measurand with Respect to: options.

» Emulation Time (default setting): Lists the measured values in the .csv file each with
the respective time stamp.

* Other Measurands: Open the list right to the option and select one of the
measurands to create a .csv file that lists each measured value selected from the list
below with reference to this measurand.

3 Click the Export button.

Result: A Save as dialog box is displayed.

4 Browse to the folder where you want to save the .csv file, enter a File name and click
the Save button.

Result: The .csv file is created and saved to the selected folder.
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Overview
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The Script view allows you to write scripts inside EcoStruxure Machine Expert
Twin using the C# programming language.

To integrate the code in the program, click the Build button on the left side of the
button bar or run the Build project command from the Build menu.

Errors that are detected during the build process are displayed in the Error List
view below the Script view.

Also refer to What Can | Use the Script View For?, page 107.
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Logs View

What’s in This Chapter
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Logs View
Overview

Contextual Menu

The Logs view provides information on how the program is running and displays
different types of messages. By default, time stamps are added and the messages
are color-coded according to their severity. You can disable the time stamp and
the color in the Properties View, page 101.

NOTE: It is also possible to disable log messages completely. Thus, if the
Logs view is empty, verify whether the Mode parameter in the Properties of
the Logs view is set to None.

Message type Description Color

Action Notification concerning a certain action executed | black
in the scene.

Communication Notification providing controller information, black
such as connection set.

Error An error has been detected. red

System Information provided during start-up of blue

EcoStruxure Machine Expert Twin.

Debug Customized messages defined in the Script black
view, page 85 with the command ‘Log.
DebugMessage<”Your message”>’ to be
generated, for example, when activating a
specific object.

Warning Advisory messages indicating that the scene is orange
not playing properly, for example, due to the
connection to the controller being interrupted.

Information General information about the instance. green

Select the check box Tail to activate an automatic scrolling function to display new
log messages that are added at the end of the Logs list. If this check box is not
selected, you will have to scroll manually to the latest log messages at the end of
the list.

Right-click a message to open a contextual menu with the following commands:

Command Description

Clear Deletes all messages from the Logs view.

Copy Copies the selected line or lines to the clipboard.

Insert Separator Inserts a line with the time stamp at the end of the messages. This can be
:tsaerftléldt.o structure the log, for example, to mark the time when a test is being
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Customizing the Logs View

To customize the log messages, select a message and configure your individual
settings in the Properties view, page 101.
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Loads View

Overview
The Loads view displays the loads that are available in the scene. This
information is relevant for discrete events mode.

Selecting a load in the Loads view also selects the load in the Model view.
Further information on the selected load is displayed in the Properties view, page
103.

Information Provided in the Loads View

To fill or update the columns of the Loads view, right-click within the Loads view
and run the command Refresh. The following information is displayed:

Column Description

Identification Displays the identifier (usually a barcode) of each load.

To modify the identifier of the load, edit the Identification parameter in the
Properties view, page 103.

Next Indicates the next action point the load will hit.
Destination Indicates the final destination of the load.
Description Provides further information on the load.

Further Information in the Properties View

For further information on the selected load and modification of the Identification
parameter as well as the color, refer to the Properties view, page 103.
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Inputs / Outputs Views

Inputs / Outputs Views

Overview

Inputs and outputs (I/Os) are relevant for connections to controllers.

The Inputs view displays the inputs the controller receives, such as sensor

signals.

The Outputs view displays the outputs that are sent by the controller, such as

control commands.

Selected inputs / outputs are displayed in green.

Red cells within the table indicate that the parameter has not been configured

correctly.

Contextual Menu

Right-click in the Inputs / Outputs table to open a contextual menu with the
following commands:

Command

Description

Add

Adds a new input or output for the controller and adds a new row to this
table. You can also add new inputs or outputs through components.

Refresh

Updates the content of the Inputs / Outputs table.

Export

Exports inputs or outputs to an Excel file.

Further Information in the Properties View

The Properties view allows you to modify the symbol and the description of the

input / output.
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Alarms View

Overview

The Alarms view displays the alarms you have created for performing controller
tests. To create an alarm, right-click a connection in the Connections view and
run the Alarms command from the contextual menu to open the Alarm Scheme
dialog box, page 71.

Information Provided in the Alarms View

The Alarms view provides the following information:

Column Description
Connection Indicates the controller to which the alarm belongs.
Alarm Indicates the description that you have set for the alarm.

When an alarm is raised, it is displayed in the Alarms view, but will also be
displayed as an advisory in the status bar of the Model view, page 77.
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Joint Editor View

Overview

The Joint Editor view allows you to create passive and active Physics Joints
between two or more body assemblies created with the Kinematization Menu,
page 33.

The Physics Joint is configurable in the editor and allows you to lock, unlock or
limit movement within the six degrees of freedom (DOF) individually.

For a joint, one reference is considered the stationary reference (rigid), while the
other is considered the moving reference (physics). The moving and the stationary
references of the joint must be located on two different body assemblies.

Example of a Physics Joint configuration in the Joint Editor:

The editor automatically verifies the configuration and indicates detected
configuration issues by a red triangle in each box that is affected. A tooltip is
provided that indicates a solution. The total number of issues detected in the
editor is displayed in the lower left corner.

The Joint Editor provides two buttons in the upper right corner:

Button Description
Moves the camera to Click to move the camera view of the editor to the upper left edge.
position 0.0.

Fits all nodes within the | Click to zoom in or out of the editor view so that all available objects

view are displayed.
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Creating Physical Joints

To create a physical joint between two assembilies, proceed as follows:

Step Action

1 Right-click in the Joint Editor view and run the command Add Body from the
contextual menu.

Result: A new body block is displayed in the Joint Editor.

2 Create a relationship between the block in the Joint Editor and an assembly in the
scene by selecting the assembly in the scene or in the Solution Explorer, right-clicking
the block in the Joint Editor and running the command Link to assembly from the
contextual menu.

Result: The name of the assembly is assigned to the selected block in the Joint Editor.

3 Repeat steps 1 and 2 to create a second block in the Joint Editor and to link it to a
second assembly in the scene.

Result: Two blocks representing two different assemblies are available in the Joint
Editor.

4 Right-click in the Joint Editor view and run the command Add Physics Joint from the
contextual menu.

Result: A Physics Joint block is added to the Joint Editor.

5 Click in the frame of the first assembly, hold down the left mouse button and draw a
connecting line to the Origin connection point of the Physics Joint block.

Result: The first assembly is defined as origin or stationary reference for the joint and
the Origin connection point is highlighted in blue.

6 Verify the configuration of the body assembly that is connected as Origin:

The Dynamics parameter Type must be set to Rigid or Physics (refer to the Properties
of Body Assemblies, page 34). If the Type = Bodiless is selected, correct the
configuration.

7 Click the Child connection point of the Physics Joint block, hold down the left mouse
button and draw a connecting line to the second assembly.

Result: The second assembly is defined as child or moving reference for the joint, the
Child connection point is highlighted in blue.

8 Verify the configuration of the body assembly that is connected as Child:

The Dynamics parameter Type must be set to Physics (refer to the Properties of Body
Assemblies, page 34).

If this is not the case, a red triangle is displayed at the upper right corner of the body
block. To adapt the configuration, right-click the assembly that is defined as child and
run the command Set to Physics from the contextual menu.

Result: The Dynamics parameter Type is set to Physics and the red triangle is
removed.

9 Configure the Physics Joint. For further information, refer to Configuring Physical
Joints, page 93.
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Configuring Physical Joints

By default, the six parameters representing the six degrees of freedom are set to
Axis Mode > Locked, meaning that motion of the joint is not allowed:

* Linear X
* LinearY
* LinearZ
* Rotation X
* RotationY
* RotationZ

To allow motion in one or more directions, select Axis Mode > Free from the list

for the respective parameters.

To restrict the motion of the moving reference for one degree of freedom, select
Axis Mode > Limited and configure a force that corresponds to a spring to keep
the body assembly within the defined limits.

The following constraints apply to the configuration of the Axis Mode with respect
to the three axes and are restricted within the software:

Case Axis 1 Axis 2 Axis 3 Description
Valid case 1 Limited: Limited: Locked General rule: At least one axis must be Locked to help
ensure stability.
-75°...75° -75°..75°
If one axis is Locked, allowed Limits for the other two axes
are between -75° and 75°.
Valid case 2 Limited: Locked Locked If two axes are Locked, the allowed Limits for third axis are
between -180° and 180°.
-180°...180°
Invalid case Limited: Free Locked This is an invalid case because if one axis is Locked.
-75°...75° The software does not allow you set one of the other axes to

Free.

With Axis Mode > Limited selected, configure the following parameters:

Parameter

Description

Limits

Configure limits for the motion of the moving
reference.

Min

Enter the maximum movement (in mm) in the
negative direction for the remaining axis or axes if one
or two axes are set to Locked.

The valid range depends on the configuration of the
Axis Mode for the three axes of motion as indicated
in the table above:

» -75°..75° with one axis set to Locked
» -180°...180° with two axes set to Locked

Max

Enter the maximum movement (in mm) in the positive
direction for the remaining axis or axes if one or two
axes are set to Locked.

The valid range depends on the configuration of the
Axis Mode for the three axes of motion as indicated
in the table above:

» -75°..75° with one axis set to Locked
» -180°...180° with two axes set to Locked

Spring

Configure the physical properties that correspond to
springs and that act on the moving reference to keep
it within the configured limits.

Stiffness

Enter a value >0 to configure the stiffness of the
spring (in N/m) that is the extent to which it can resist
deformation in response to an applied force.
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Parameter

Description

Damping

Enter a value >0 to configure the damping of the
spring (in N-s/m) that is the resistance against fast
changes in displacement and that contributes to bring
the spring to rest quickly.

Enable Drive

Select this option to use active joints. Refer to
Configuring Active Joints, page 94.

NOTE: In the Properties of the Child assembly, set the Dynamics
Parameters to Type = Physics for allowing the physical simulation to display

the motion in the scene.

By combining the physical joints feature with the functions provided in the
Kinematization menu, you can create customized robot kinematics.

Configuring Active Joints

You can also configure active or motorized joints that interact with the geometry by
using forces. To achieve this, set the Axis Mode to Free or Limited and configure

the following parameters:

Parameter

Description

Enable Drive

Select this option to use active or motorized joints to
keep a moving reference within the configured limits.

Drive Type

Select an option from the list to define the controller
input that is valid for the motor:

» Velocity: A velocity value for the motor (in Units)
is provided by a variable from the controller.

* Forward/Backward: Boolean forward/backward
signals are provided by a variable from the
controller.

» Custom: Select this option to use customized
motors or positioners. If they meet the
requirements defined in Customized Motors or
Positioners, page 42, they are available for
selection in the Custom Drive list and can be
added to the selected joint. You can configure
them in the Properties view (see the How to Use
Device Catalogs User Guide).

The motor is configured with the parameter Drive >
Motor.

Drive

Active joints are controlled by drives. The drive is a
proportional derivative drive that applies a force
according to the following formula:

F = stiffness * (target position - position) + damping *
(target velocity - velocity)

Motor

Configure the motor according to the selection for the
parameter Drive Type.

The motor parameters are configured as described in
the How to Use Device Catalogs User Guide.
Alternatively, you can right-click the motor node in the
Solution Explorer and control the motor manually
with the Stop, Start, Forward, Backward
commands.

Spring

Configure the coefficients used by the spring drive to
move the child body assembly (moving reference)
through forces.

Use the Stiffness parameter to apply a force that is
proportional to the detected position error.

Use the Damping parameter to apply a force that is
proportional to the detected velocity error.

94
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Logic Configurator View

The Logic Configurator view allows you to configure logical relations between
the elements of the scene in a graphical editor without the need for C#
programming language skills. For further information, refer to the Logic
Configurator User Guide.
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Change History View

What’s in This Chapter
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Change History View

Overview

The Change History view records modifications performed in the Model view
such as adding an object.

You can right-click an entry in the list and run the command Set the assembly
[ASSEMBLY NAME]’s properties back to what they were before this action
from the contextual menu to undo this specific action.

96 EI00000005022.05



Solution Explorer View Getting Started

Solution Explorer View
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Solution Explorer View

Overview

The Solution Explorer view lists the components you are using in the Model in a
tree structure consisting of categories:

* Assemblies
¢« Motors
+ Controllers

By default, the items that are available under the Assemblies node are grouped
by section, as first sub node and then by the type of assembly as second sub node
(for example, Lexium P Robot). To avoid the categorization according to the type
of assembly, click the button Do not categorize the assemblies in the upper part
of the Solution Explorer view, on the left-hand side of the Search field.
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Solution Explorer View

Category Assemblies

Category Motors

The category Assemblies provides the Sections available in the Model as sub
nodes. Assemblies selected in the Solution Explorer view are highlighted in the
Model view. You can drag assemblies between different Section sub nodes. As
an alternative, you can select the assembly you want to move and then change
the section it is placed under in the Properties view. By editing the Name
parameter in the Properties view, you can rename sections.

Right-clicking the Assemblies node opens a contextual menu with the following

commands:
Command Description
Add Section Adds a node Section[n+1] below the last section node.

Show All Sections

Displays all sections that have been hidden previously.

Collapse All

Closes all sub nodes that are open.

Right-clicking a Section sub node opens a contextual menu with the following

commands:

Command

Description

Hide All Sections But
This

Displays in the Model view only the assemblies that are placed in the
selected section.

Show All Sections

After running the command Hide All Sections But This this
command restores the assemblies of all sections in the Model view.

Hide Assemblies

Hides the assemblies and the floor of the selected section from the
Model view.

Lock Assemblies /
Unlock Assemblies

Locks the assemblies that are available in the selected section. New
assemblies that you are adding are not locked.

Fit

Resizes the floor to fit around the assemblies placed in the Model
view.

Delete Section[n]

Deletes the selected section. It is not possible to delete the last
remaining section.

Disable Assemblies

Disables the assemblies that are available in the selected section. To
indicate this, they are displayed gray in the Model view. If you attempt
to place a load on a disabled assembly, the load will “fall through” the
assembly. To re-enable disabled assemblies, run the Disable
Assemblies command again.

Collapse All

Closes all sub nodes that are open.

Right-clicking the sub node of an assembly allows you to disable or delete this

assembly.

Right-clicking a motor sub node opens a contextual menu with the following

commands:
Command Description
Start / Stop Starts / stops the motor.

Backward / Forward

Toggles the moving direction of the motor.

Copy Copies the motor.
Disable Disables the motor.
Delete Deletes the motor.

98
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Category Controllers

Right-clicking the Controllers node opens a contextual menu providing the Load
command. It opens a File Open dialog box that allows you to browse for the
controller file.

Your file contains script code created or modified by you or by someone else. The
execution of the script code may compromise the security of your IT system.

AWARNING

INFORMATION SYSTEM VULNERABILITY

» Ensure the integrity of the script code contained in the file by ascertaining
the originator and intent of the script before opening the file.

* Do not open the file if you cannot determine the originator and intent of the
script, including confirming any modifications that may have been made.

» Verify and confirm that you want to execute this code when using the model
contained in the file.

Failure to follow these instructions can result in death, serious injury, or

equipment damage.

When attempting to open a file with a model containing script code, you are asked
to acknowledge this advisory and accept responsibility for the execution of the
code of the embedded script.

After the controller has been loaded, it will be displayed as a new sub node of the
Controllers node.
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Statistics View

Overview

What’s in This Chapter
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The Statistics view provides information about the loads in the scene monitored
by sensors.

You can monitor different types of sensors, such as scanners, weights, counters
and eaters. Scanners, for example, provide information about how many loads
they have scanned. The information for buttons indicates how many times they
have been pressed.

Managing Sensors

To add a sensor to the Statistics view, right-click it in the Model view and select
the option Observe in the contextual menu.

To modify the name of a sensor, proceed as follows:

Step Action

1 Select the sensor in the Model view.

2 Edit the Name parameter in the Properties view.

Result: The name is changed in the Model view.

3 To display the new name also in the Statistics view, right-click the sensor in the Model
view and clear the option Observe in the contextual menu and then select the option
Observe again.

100

EI00000005022.05



Properties View Getting Started

Properties View

What’s in This Chapter

Properties VIEW. ... ..o 101

Properties View

Overview

The Properties view provides information about items selected in different views
of EcoStruxure Machine Expert Twin, such as assemblies in the Model view,
buttons in the Control Panel or Connections. Parameters of the Properties view
that can be edited are displayed in black. Fixed values that cannot be edited are
displayed in gray.

The buttons in the upper left part of the view allow you to select whether to display
the properties as one list or grouped in categories.

Properties of the Logs View

To customize the log messages, select a message and configure your individual
settings in the Properties view:

Message parameters:

Parameter Description
Font Enter the font type and size for displaying the selected log message type.
For example:

[Font: Name=Courier New, Size=8.25, Units=3,
GdiCharSet=0, GdiVerticalFont=False]

Mode Select from the list whether to display the messages in Color or in Black.
For information on the types of messages and the corresponding color, refer
to the Logs View, page 86.

The option None switches off the log function. No new log messages will be
displayed.

Time/Clock Select the format of the time stamp from the Time/Clock list. The selected
format is indicated in the Log Format line.
Log Format * None: No time stamp is displayed for the log messages.
» Clock: The time stamp is displayed in
Log Format: [HH:mm:ss.fff]
» Elapsed: The time stamp is displayed in
Log Format: [ {0:dd\.hh\:mm\:ss\.£f£ff}]
+ Simulated: The time stamp is displayed in
Log Format: [{0:dd\.hh\:mm\:ss\.f£f}]
+ DateTime: The time stamp is extended by the date and displayed in
Log Format: [yyyy-MM-dd HH:mm:ss.fff]

Elapsed and Simulated differ if the time scale (parameter Scale in the
Model menu, page 29) is set to value other than 1x as the Simulated time
would differ from elapsed time. The Simulated time is calculated from the
Elapsed time multiplied by the selected scaling factor.

Search Select the check box to highlight components that match a word in the
selected log message.
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File parameters:

If activated, log files are saved in the user directory of the logged in Windows user
in the following default path:

%localappdata%\Schneider Electric\Machine Expert Twin\1\Work\Logs

Parameter Description

Mode The following options are provided for log files:
» None: No log file is created.

» File: Alog file is created in the default path with the default name debug.
log.

» FileDate: A log file is created with the file name derived from the system
date and time of day when EcoStruxure Machine Expert Twin has been
started.

* FileModelName: A log file is created when a project is opened or saved
with the project file name as log file name.

LogFile Wrap This option is available if a log file is to be created. It defines how the log file
Mode is buffered:

« Continuous: Append new log entries to an existing log file.

»  Wrap: Append new log entries to an existing log file until the maximum
threshold is reached. Then the oldest entries are overwritten.

» Create new: Append new log entries to an existing log file until the
maximum threshold is reached. Then a new log file is created.

Filter parameters:

Parameter Description

Text Enter text you want to apply as a filter to the log messages. Only messages
that contain this text are displayed in the Logs view.

Type Select from the list the types of messages that are displayed in the Logs
view:

* None
* Action
+ Communication

» Error

« System
* Debug

*  Warning

* Information

For further information on the different message types, refer to the chapter
Logs View, page 86.

Highlight parameters:

Parameter Description
Text Enter a text string you want to highlight in the log messages.
Color Select the color to use for highlighting.
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Properties of the Loads View
To customize a load, select it in the Model view and configure your individual
settings in the Properties view:
In Identification, the Type parameter indicates the type of the load, for example,
a box. With the Identification parameter, you can modify the identifier of the load

which is usually a barcode.

With the other parameters, you can define physical characteristics of the load, the
dimensions, the color and the position in space (in a cartesian coordinate system).

NOTICE

ASSEMBLY OVERLOAD

Do not exceed the capacity of the assembly when defining the physical
characteristics of the load.

Failure to follow these instructions can result in equipment damage.

The capacity of the device constituting the assembly is specific to that device, is
highly variable across devices and types of payloads, and those payloads are then
subject to kinetic forces. It is your responsibility to understand what these capacity
limits are when designing the simulation of the assemblies. You may have to
research the device’s documentation, data sheets, catalogs, or other such
documentation to ascertain the relevant limits.

Properties of the Inputs / Outputs View

The Properties view allows you to modify the symbol and the description of the
input or output.

Properties of the Alarms View

The Properties view provides further information on the alarm selected in the
Alarms view, page 90 for controller tests.

Properties of the Solution Explorer View

The Properties view allows you to modify the settings of the Assemblies, Motors
or Controllers selected in the Solution Explorer view. For further information on
the properties of catalog objects, refer to the EcoStruxure Machine Expert Twin
How to Use Device Catalogs User Guide.
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Are Catalogs Saved With the EcoStruxure Machine Expert

Twin Project?

No, EcoStruxure Machine Expert Twin project files contain information about the
scene, assemblies, properties, connections, linked controller input and output
variables, camera views and scripts.

If you are using customized catalogs, references to the objects of the catalogs are
stored in the EcoStruxure Machine Expert Twin project files.

How Can | Share a Project with Customized Catalogs?

When you open a EcoStruxure Machine Expert Twin project file, the catalogs
referenced in the project must be available and are by default retrieved from the
EcoStruxure Machine Expert Twin installation folder.

If you share a project that is using customized catalogs, provide the DLL files of
the customized catalogs together with the project and save them on the target PC.
Upon start-up of EcoStruxure Machine Expert Twin the Select Catalog(s) dialog
box is displayed. Click the browse (...) button to browse to the folder where the
customized catalogs are stored.

EI00000005022.05

105



Getting Started

FAQ

How Can | Position an Assembly Up And Down in the

Scene?

If you select an assembly in the scene and move the mouse, the assembly is
moved in the XY-plane.

To lock the position in the XY-plane and to move the assembly up and down in Z
direction, hold down the Shift key and move the mouse.

How Can | Link or Snap Conveyors in the Scene?

To link two conveyors, hold down the Ctrl key and drag the red snapping point
from one conveyor to the blue snapping point of another conveyor or vice versa.
As soon as the snapping points collide, the assemblies are snapped and you can
release the Ctrl key.

To unsnap two conveyors, select the component you want to unattach, hold down
the Ctrl key and drag the component to another position in the scene.

How Can | Create a Random Load in the Scene?

Bring the cursor to the position where the load is to be created and press the F key
to create a load of type box or hold down the Shift key and press the F key to
create a load of type sphere.

To create a load on a conveyor, select the conveyor and press the F key.

How Can | Make the Camera View Following a Load?

Select a load and press the F key to make the camera following the load. To
modify the zoom level, use the scroll wheel of the mouse while following the load.

To stop following a load, press the F key again.
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What Can | Use the Script View For?

Intended Use

The Script view allows you to execute simple tasks inside a project such as
performing clean-up actions on reset or automatically changing the camera view.

The Script view is not intended to be used for developing customized catalogs or
assemblies.

In case you use scripts in your project, a message is displayed when the project is
loaded.

Your file contains script code created or modified by you or by someone else. The
execution of the script code may compromise the security of your IT system.

AWARNING

INFORMATION SYSTEM VULNERABILITY

» Ensure the integrity of the script code contained in the file by ascertaining
the originator and intent of the script before opening the file.

» Do not open the file if you cannot determine the originator and intent of the
script, including confirming any modifications that may have been made.

» Verify and confirm that you want to execute this code when using the model
contained in the file.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

When attempting to open a file with a model containing script code, you are asked
to acknowledge this advisory and accept responsibility for the execution of the
code of the embedded script.

Script Code Example

The following script code example modifies the camera view if the scene is locked.
using System;

using System.Numerics;

using System.Windows.Media;

using System.Ling;

using Experior;

using Experior.Core;

using Experior.Interfaces;

using Experior.Core.Loads;

using Experior.Core.Routes;

using Experior.Core.Communication.PLC;

public partial class Main

{

public int 1 = 0;

public int viewID =1;

public void Step(float deltatime)

{

//enable automatic change of camera view only when scene is
locked

if (Experior.Core.Environment.Scene.Locked)
{

// increment a count every léms (step time)
i=1i+ 1;

// check counter value 500 x l6ms = 8s

if (1 >= 500)

{

// reset counter
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i = 0;

//check is viewID is within valid limits and increment the
value

if (viewID < 9)viewID = viewID + 1;

else viewID = 1;

// change camera view with blending time of 1000ms
Experior.Core.Environment.Scene.Camera.MoveTo (viewID,1000) ;
// create logs message

Log.Write ("Camera view changed to " + viewID.ToString());
}

}

}

public void Reset ()

{

// reset camera view
Experior.Core.Environment.Scene.Camera.MoveTo (1,1000) ;
Log.Write ("Camera view changed to 1");

}

public void On (object trigger, string symbol)
{
}

public void Off (object trigger, string symbol)
{
}

}

How Can | Streamline the Start-up Process?

Overview

You can start EcoStruxure Machine Expert Twin with specific start-up options by
using command-line arguments that you can enter from different locations:

* By using the Windows command prompt:

Enter cd C:\Program Files\Schneider Electric\EcoStruxure
Machine Expert Twin to change to the installation directory and append one
of the command-line arguments listed below to MachineExpertTwin.exe

+ By right-clicking the Machine Expert Twin icon on the desktop of your PC and
running the Properties command. Select the Shortcut tab and append one of
the command-line arguments listed below to the string in the Target field.

Command-Line Arguments

The following command-line arguments are available:

Command-line argument Description

-help Opens a command prompt with a list of
-2 available command-line arguments.
-config Displays the Select Catalog(s) dialog box

during start-up.

-headless Starts EcoStruxure Machine Expert Twin in
headless mode and enables the webapi and
graphicsserver.
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Command-line argument

Description

-webapi [off|filepath]

Enables webapi and specify the webapi
configuration file to use or disable it ([of£]).

webapi is only accessible from localhost
connections.

-graphicsserver [off]

Enables graphics server or disables graphics
server [off].

-model <filepath>
-modelfile <filepath>

EcoStruxure Machine Expert Twin opens a
project if the argument matches the name of an
existing project.

-phy
-physics

Starts EcoStruxure Machine Expert Twin in
physics mode without displaying the Select
Catalog(s) dialog box during start-up.

—frictiontype <Patch|OneDirectionall]
TwoDirectional>

Starts the physical simulation with the selected
friction type (only available in physics mode).

By default, EcoStruxure Machine Expert Twin
uses the Patch mode.

—libs <directory>

Sets an additional library / catalog directory.

Example:

-libs C:\Projects\Demo\

Two prerequisites need to be fulfilled:
* The directory exists.

» The directory contains an EcoStruxure
Machine Expert Twin catalog DLL file.

—debug [none|debug|detailed]

Enables the debug level. For further information
on the debug levels, refer to Debug Section,
page 25.

—autostart

Starts the physical simulation after the project is
loaded.
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D
digital twin:

A digital twin refers to a virtual representation or digital replica of a physical
object, system, or process. It is a digital counterpart that simulates the behavior,
characteristics, and performance of its physical counterpart in real-time or
historical contexts. The concept of a digital twin allows for the integration of the
physical and digital worlds, enabling organizations to monitor, analyze, and
optimize the performance of their assets or processes.

EcoStruxure Machine Expert Twin provides features for visualization, simulation,
and emulation of machines and automation lines throughout the complete
lifecycle.

E

emulation:

Based on the ISO 24765-2017 International Standard - Systems and software
engineering--Vocabulary, emulation is defined as the use of a data processing
system to imitate another data processing system, so that the imitating system
accepts the same data, executes the same programs, and achieves the same
results as the imitated system.

M

Model view: In EcoStruxure Machine Expert Twin, the Model view provides the
graphical representation of the scene.

P

physical simulation: The physical simulation is a software library that is designed
to simulate and model physical systems in a computer-generated environment. It
is used to create realistic and dynamic animations and simulations of objects,
environments, and interactions between them. In EcoStruxure Machine Expert
Twin the physical simulation uses mathematical algorithms to simulate physical
phenomena, such as gravity, friction, and collision detection.

project: An EcoStruxure Machine Expert Twin project file is saved with the
extension *.experior. It contains the information about assemblies, connections,
loads, settings.

S

scene: In the EcoStruxure Machine Expert Twin context, a scene is a
representation of a set of assemblies interacting with loads.

simulation:

Based on the ISO 24765-2017 International Standard - Systems and software
engineering--Vocabulary, simulation describes two concepts:

* A model that behaves or operates like a given system when provided a set of
controlled inputs.

» The use of a data processing system to represent selected behavioral
characteristics of a physical or abstract system.

In the context of this manual, the term simulation is used whenever it is referred to
modeling physical systems in EcoStruxure Machine Expert Twin.

STEP: (STandard for the Exchange of Product model data) This ISO 10303
standard specifies a standard file format for 3-D models and allows for product
data exchange across different platforms.

EIO0000005022.05 11
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U

URDF: (unified robotics description format) A special type of eXtensible Markup
Language (XML) file that includes the physical description of a robot and contains
information on the mechanical structure, joints, 3-D modelling graphics, motors
and colliders. URDF files are provided by numerous robotic manufacturers for
download. EcoStruxure Machine Expert Twin allows importing URDF files for
integrating third-party robots into a project without manual programming.
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